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1. Benvenuti nell’'help COPA-DATA

GUIDA GENERALE

Nel caso in cui non abbiate trovato delle informazioni che cercavate o se avete dei consigli relativi al
completamento di questo capitolo dell'help, mandate una Mail a documentation@copadata.com
(mailto:documentation@copadata.com).

SUPPORTO ALLA PROGETTAZIONE

Se avete delle domande concernenti progetti concreti, potete rivolgervi per E-Mail al
support@copadata.com (mailto:support@copadata.com).

LICENZE E MODULI

Nel caso in cui doveste constatare che avete bisogno di altri moduli o licenze, rivolgetevi ai nostri
dipendenti all'indirizzo sales@copadata.com (mailto:sales@copadata.com).

2. Editor

zenon consiste di due componenti principali, I'editor e il Runtime. | progetti vengono realizzati

nell'editor dove ne avviene anche la manutenzione, mentre la loro gestione e osservazione avviene nel

runtime. Nel capitolo Editorimparerete a conoscere le componenti base dell’editor, Vi saranno fornite
delle informazioni relative a come lavorare con il Manager di progetto (auf Seite 86), Barre dei simboli
(auf Seite 27), Menu (auf Seite 54) e Profili editor (auf Seite 77). Trovate delle spiegazioni concernenti il

menu contestuale degli elementi in un’‘immagine nel capitolo Immagini.


mailto:documentation@copadata.com
mailto:support@copadata.com
mailto:sales@copadata.com

2 Informazioni sulla licenza

L°Editor di zenon funziona solamente in presenza di una licenza valida. La licenza viene
calcolata sulla base del numero dei Tags e 10s di cui si ha bisogno. | dettagli sul tema

licenze li trovate al capitolo Licenze.

L Editor é a disposizione come zenon Supervisor e come zenon Operator per > sistemi
operativi embedded. Le due versioni si differenziano nell’'ampienzza delle funzioni

disponibili. Per i dettagli vedi Limitazioni per zenon Operator.

SQL SERVER

L’editor di zenon lavora con una banca dati SQL. Questa viene <installata insieme> all’Editor di
CD_PRODUCTNAME. Per creare una connessione, |'Editor si collega al server della banca dati
(zenDBSrv.exe) di zenon. Quest ultimo instaura la connessione con il server SQL.

FUNZIONAMENTO MULTI-MONITOR

Se su un PC sono in funzione piu monitor, i dialoghi, le barre dei simboli ecc possono essere spostati su altri

monitor. La posizione di questi ultimi viene salvata e conservata al momento del prossimo start.

¥ Informazioni

Se, quando I’editor viene riavviato, non é disponibile che il monitor principale, é possibile
che degli elementi spostati non siano eventualmente visualizzati nell’area visibile. Per
riportare tutti gli elementi sul monitor principale, dovete attivare il Profilo standard (auf

Seite 83). In tal modo, le posizioni vengono riportate ai valori standard.

3. Avwvia l'editor

Per avviare |’editor, avete a disposizione diverse opzioni:

» cliccate sul simbolo zenon sul desktop del Vostro PC.

» Apertura mediante il menu Windows File -> COPA-DATA -> zenon Editor.



» Avvio tramite il Startup Tool. Esso consente la gestione di pil versioni di zenon e la

configurazione dell’editor e del runtime prima dello Start.

» Per Windows Autostart.

SERVIZIO ZENADMINSRV

Per avviare |'editor, deve essere avviato il servizio zenAdminSrv . Se il servizio non é disponibile,
riceverete il messaggio "L editor non puo essere avviato perché il servizio 'zenAdminSrv' non e
raggiungibile!". Attivate il servizio e riavviate |'editor.

Al momento dello start tramite Windows Autostart, zenon cerca di avviare per cinque volte |'editor e
poi si ferma emettendo la segnalazione di errore che il servizio non & raggiungibile.

4. Compatibilita:

L’editor di zenon & completamente compatibile con le versioni di numero inferiore. | progetti che sono
stati realizzati usando una di queste versioni, possono essere aperti e modificati in qualsiasi momento.

Al momento di aprire un progetto con un numero di versione inferiore:

» il progetto viene convertito automaticamente

» viene creato automaticamente un backup di progetto

Attenzione: i progetti convertiti non possono piu essere aperti nell’editor di una versione inferiore. Il
backup di progetto generato al momento della conversione, pero, puo continuare ad essere aperto e
modificato.

COMPATIBILITA FRA EDITOR E RUNTIME

Con I’editor di zenon, possono essere creati i file runtime per diverse versioni del runtime. La versione
del runtime, dunque, non deve necessariamente essere la stessa di quella dell’editor. Questa
compabilita verso il basso e particolarmente utile se si intende utilizzare dei sistemi misti. Ad esempio:
un progetto viene realizzato con |'editor della versione 6.50, ma puo essere avviato anche con il runtime
della 6.22.



& Attenzione

Se in un progetto vengono impostate delle proprieta con un editor di una versione
superiore, le quali non sono disponibili con una versione precedente, queste proprieta
non sono a disposizione se si lavora con quest ultima versione. Cio puo avere delle

conseguenze indesiderate nel funzionamento runtime.

CREA FILE RUNTIME

Per creare nell’editor dei file runtime per versioni dal numero di serie inferiore, procedere come segue:
1. selezionate il progetto nella struttura ad albero.
2. passate alla proprieta di progetto, in particolare alla sezione Generale
3. aprite la lista a cascata della proprieta Crea RT file per

4. selezionate la versione desiderata:

e Default: | file runtime vengono generati per la versione attuale dell”Editor.

6.20 SP4:ifile runtime vengono generati per la versione 6:20 Servicepack 4.

6.21 SPO:ifile runtime vengono generati per la versione 06:21:00 Servicepack O.

e 6.21 sP1l:ifile runtime vengono generati per la versione 06:21:00 Servicepack 1.

e 06:22:00 sPO:ifile runtime vengono generati per la versione 06:22:00
Servicepack 0.

e 06:22:00 sP1:ifile runtime vengono generati per la versione 06:22:00
Servicepack 1.

e 06:50:00 sPO:ifile runtime vengono generati per la versione 06:50:00
Servicepack 0.

e 06:51:00 sPO:ifile runtime vengono generati per la versione 06:51:00
Servicepack 0.

Attenzione: Per garantire la consistenza dei file runtime, bisogna crearli di nuovo dopo ogni modifica di
questa proprieta. Anche le configurazioni di tutti i driver vengono convertite. Le impostazioni che non
esistono nella versione corrispondente, vengono settate su quelle di default.



Superficie

Zzenon

XML

| dati esportati in formato XML sono a disposizione anche per I'import in versioni dell’editor con numero
di serie piu alto.

Eccezione: se dei dati del RGM vengono salvati mediante la funzione di export nel runtime
direttamente in formato XML, essi non possono essere importati di nuovo.

5. Superficie

L'interfaccia utente dell'editor si articola in diversi settori:

i
:
:
i

=3

Rl —

w B % | operty help

Cutput winoaw

Insert project: ‘GLCBALPROJEKT'
Load project 'GLOBALFROVERT"
nsert proiect: '3922'
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Elemento

01 - Barre simboli:

02 - Manager di progetto:

03 - Visualizzazione dettagliata del
manager di progetto:

04 - Finestra principale:

05 - Barra simboli Elementi:

06 - Proprieta

07 - Guida proprieta:

08 - Finestra di emissione

Contenuto

Raccolta delle barre simboli (auf Seite 27) per I’editor e i suoi moduli.
Sono a disposizione per:

»  Finestra docking (auf Seite 31)
»  Orientamento (auf Seite 31)
» Immagini (auf Seite 36) / Simboli (auf Seite 38)
> Profili editor (auf Seite 40)
»  Elementi (auf Seite 41)
»  Barra menu (auf Seite 38)
»  Production & Facility Scheduler (auf Seite 43)
>  Trasporto remoto (auf Seite 45)
»  Generatore di rapporti (auf Seite 47)
> File runtime (auf Seite 48)
> Livelli di visibilita (auf Seite 49)
»  Macro VBA (auf Seite 50)
Visuale ad albero del manager di progetto

Dettagli concernenti il modulo selezionato nel manager di progetto.

Workspace principale; qui vengono visualizzati documenti come
immagini o report.

Barra simboli per gli elementi delle immagini - elementi vettoriali e
dinamici

Mostra le proprieta dell’ oggetto selezionato. A questo scopo avete a
disposizione tre modalita, che vengono selezionate nella Barra
simboli delle porprieta (auf Seite 52).

Mostra delle brevi spiegazioni che concernono le proprieta di
immagini, variabili, funzioni e altri elementi che vengono
parametrizzati.

Visualizzatzione di segnalazioni se i progetti sono compilati e salvati
nel runtime.
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09 - Barra di stato: Mostra delle informazioni di stato per la disponibilita editor e per
immagini.

10 - Barra simboli Proprieta: Definisce visualizzazione e ordine delle proprieta; mostra la Guida
proprieta (auf Seite 145).

11 - Lista incrociata:

Decidete quale finestra deve essere mostrata:

» nellalista a cascata alla voce opzioni

L'ordine della finestra puo essereadattata (auf Seite 12) individualmente. La finestra principale & |'unica
finestra che non pud essere nascosta.

5.1 Adatta visualizzazione

Tutte le finestre dell’editor possono essere ordinate individualmente sullo schermo. Passate
all'impostazione per ordinare le finestre cliccando con il tasto destro del mouse sul bordo della finestra.
Le proprie impostazioni possono essere salvate nei Profili editor (auf Seite 77).

MENU CONTESTUALE FINESTRA

Opzioni Stato Funzione
Non Attiva La finestra selezionata puo essere posizionata liberamente sul dektop.
ancorata Viene visualizzata nella finestra principale. Avete la possibilita di

visualizzare piu finestre in quella principale e passare dall’una allaltra.

Cliccando due volte sul titolo si passa fra non ancoratae
ancoraggio.

inattiv | Lafinestra viene ancorata. La proprieta ancoraggioeéattiva.
0.

(default)
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Ancoraggi
o

Apri
nella
finestra
principal
e

Escludi
automatic
amente

Attiva

(default)

inattiv
o.

Attiva

inattiv
o.

(default)

Attiva

inattiv
o.

(default)

Tenendo premuto il tasto sinistro del mouse premuto e possibile
spostare a piacere le singole finestre. Durante questo spostamento, un
Aiuto di posizionamento (auf Seite 14) indica la posizione in cui & stata
inserita la finestra. Al rilascio del tasto del mouse, la finestra viene
ancorata e adattata alle altre adiacenti.

Passandodanon ancorataeancoraggio, lafinestraviene
inserita in corrispondenza dell’ultima posione nella quale era ancorata.

Cliccando due volte sul titolo si passa franon ancoratae
ancoraggio.

Un consiglio: se volete spostare una finestra, ma non ancorarla, tenete
premuto durante lo spostamento il tasto Ctrl. In questo caso non viene
visualizzato nessun aiuto per facilitare il posizionamento.

Tenendo premuto il tasto sinistro del mouse premuto e possibile
spostare a piacere le singole finestre. Quando lasciate il tasto, esse
vengono visualizzate nel posto corrispondente in primo piano.

La proprieta non ancorataeattiva.
La finestra viene visualizzata in quella principale come tab.

Tutti i tab vengono visualizzati nella finestra principale. Cliccando sul
titolo della finestra, passate da un tab all altro.

Per visualizzare un tab di nuovo in forma di finestra, aprite il menu
contestuale cliccando con il tasto destro del mouse sul titolo della
finestra e settate la proprieta Apri nella finestra
principaleanon attiva.

La finestra viene visualizzata in modo normale.

Non appena la finestra perde il focus del mouse, viene posta sullo sfondo.

I titolo della finestra viene visualizzato sul lato sinistro dell’editor.

Per riportare la finestra in primo piano, spostate il mouse sul titolo della
finestra.

La finestra viene visualizzata sempre in primo piano.

13



Chiudi La finestra viene chiusa.

Per renderla di nuovo visibile, selezionate nella Barra menu -> Opzioni, la
voce > Nome finestra

5.2 Posiziona finestre

POSIZIONAMENTO

Nell’editor di zenon tutte le finestre possono essere disposte a piacere sul desktop facendo uso di:

» Drag & Drop: le finestre vengono trascinate nella posizione desiderata e vengono posizionate in

modo libero (non ancorata), oppure ancorate.

» Doppio clic sulla barra titoli: si passa franon ancorataeancoraggio.

AIUTO PER IL POSIZIONAMENTO

Quando si spostano delle finestre all interno della superficie dell’editor, il sistema visualizza degli aiuti
volti a facilitare il posizionamento. Questi ultimi rappresentano le finestre, o meglio i loro bordi.

Questo elemento rappresenta I’area al bordo dell’editor.

POSIZIONA FINESTRE

Per posizionare un elemento in modo ancorato:

1. spostate I'elemento servendovi del mouse fino a raggiungere la posizione desiderata

14



comparira sullo schermo I"aiuto di posizionamento

esso rappresenta una finestra e i suoi settori
a) Centro: finestra intera

b) su meta superiore

C) giu: meta inferiore

d) destra: meta di destra

e) sinistra: meta di sinistra

o il bordo dell”editor

4. spostate il mouse verso |'aiuto di posizionamento centrale o quello sul bordo dell’editor e,
guando li avete raggiunti, portatevi nell’area desiderata

5. I'area dell’editor sulla quale I'elemento & posizionato al momento del rilascio del tasto del
mouse, viene colorata di blu

6. spostate il mouse all’interno dell’aiuto di posizionamento finché |'area desiderata non si colora
di blu

7. rilasciate il tasto del mouse e |I'elemento verra posizionato

ESEMPI
1. Lafinestra proprieta viene spostata ancorata.

15



Superficie

Zzenon

2. Anche in questo caso compariranno gli aiuti di posizionamento.

3. L’indicatore del mouse viene portato sulla freccia superiore dell"aiuto di posizionamento

centrale.

16



Superficie

Zzenon

4. |l settore di inserimento dell’editor diventa blu.

17



Superficie

Zzenon

5. Quando sirilascia il tasto del mouse, la finestra viene inserita nella posizione evidenziata:

EREE o @

oad project 'DOFUD"
sad prodect 'REPORTY

6. adesso si deve portare il puntatore del mouse sul bordo superiore dell’aiuto di posizionamento.

18



7.

Il settore di inserimento dell’editor diventa di nuovo blu.

DOFD
Load project 'REPCRT'

Superficie

Zzenon

19



Superficie

Zzenon

8. Quando si rilascia il tasto del mouse, la finestra viene inserita nella posizione evidenziata:

Froperty heip

CQutput window v o x

Load project 'DOFD" -
Load project 'REPORT'

@

3

5.3 Modalita schermo intero

Nell’editor di zenon potete visualizzare la finestra principale nella modalita a schermo intero. Per far
cio:

» usate la combinazione di tasti Shift+F9
oppure

» selezionate nella lista a cascata Finestra, |'inserimento Modalita a schermo intero

La modalita schermo intero esclude tutte le altre finestre e mostra solamente quella principale con tutti i
documenti aperti (immagini, rapporti ....) in forma di immagine piena che occupa tutto lo schermo.

La modalita schermo intero puo essere terminata tramite:
» il pulsante visualizzato per chiudere la modalita schermo intero

» la combinazione tasti Shift +F9

20



» iltastoEsc

LAVORARE NELLA MODALITA A SCHERMO INTERO

Nella modalita a schermo intero viene visualizzato un menu che serve a terminare questa modalita di

visualizzazione e ad aprire determinate finestre e barre simboli.

L e

[Volbild schiiegen

Finestre ancorabili ~

Symbolleistenoptionen ~

Parametri

Chiudi schermo intero

Finestra docking

Barre dei simboli

Descrizione

Chiude lo schermo intero. In alternativa, usate anche la
combinazione di tasti Shift+F9, oppure il tasto Esc.

Lista a cascata che serve ad aprire le finestre:
> Proprieta
> Help proprieta

Le finestre vengono aperte la prima volta in una posizione
determinata in modo fisso. Poi possono essere
posizionate liberamente e vengono aperte in seguito
nella modalita a schermo intero in corrispondenza della
posizione definita individualmente.

Lista a cascata che serve ad aprire le barre simboli:
> Immagini

> Orientamento

> Livelli di visibilita

> Elementi

Le barre simboli vengono aperte la prima volta in una
posizione determinata in modo fisso. Poi possono essere
posizionate liberamente e vengono aperte in seguito
nella modalita a schermo intero in corrispondenza della
posizione definita individualmente.
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Superficie

Zzenon

5.4 Combinazioni di tasti

GENERALE
N

Aprila guida Fl

Awvia / chiudi modalita schermo intero Shift+F9

Remote: Chiudi modalita schermo intero Ctrl+Alt+Shift+F

Avvia VSTA Editor Alt+F10

Avvia I'Editor VBA Alt+F11

Wizard Apri selezione Alt+F12

Apri explorer con particolare attenzione alla cartella | Ctrl1+Alt+E
SQ per il progetto attuale.

Corrisponde a: $ProgramData%\COPA-
DATA\ [SQL-Ordner]\ [UID]\FILES

Apri explorer con particolare attenzione ai file del Ctrl+Alt+D
progetto attuale.

Corrisponde a: ¥CD_USERDATAS%

Ad esempio:
C:\Users\Public\Documents\<CD_ zenon
_Projects

PROFILI EDITOR

Carica profilo editor 1 Shift+F1l
Carica profilo editor 2 Shift+F2
Carica profilo editor 3 Shift+F3
Carica profilo editor 4 Shift+F4
Carica profilo editor 5 Shift+F5
Carica profilo editor 6 Shift+F6
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Carica profilo editor 7 Shift+F7

Carica profilo editor 8 Shift+F8

Salva visuale editor attuale come:

Profilo editor 1 Ctrl+Shift+F1
Profilo editor 2 Ctrl+Shift+F2
Profilo editor 3 Ctrl+Shift+F3
Profilo editor 4 Ctrl+Shift+F4
Profilo editor 5 Ctrl+Shift+F5
Profilo editor 6 Ctrl+Shift+F6
Profilo editor 7 Ctrl+Shift+F7
Profilo editor 8 Ctrl+Shift+F8

EDITOR GRAFICO

Indicazioni sulle combinazioni di tasti: il segno di pili (+) significa che i tasti vanno premuti insieme.
Ad esempio:

Ctrl+A significa: tenere premuto il tasto ctrl e poi premere il tasto a.

Ctrl++ significa tenere premuto il tasto ctrl e premere il tasto +.
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GENERALE

Finestra principale: scrollare contenuti con mano
per trascinamento

Superficie

tenere premuto spazio

Chiudi immagine attuale

Ctrl+F4

Apri proprieta

Alt+Invio

SELEZIONA

Seleziona pil oggetti

Tenere premuti Shift oppure
Ctrl

Deselezionare un elemento in caso di multiselect

Ctrl+Clic del mouse

Selezione: modifica successione. definisce
I’elemento nei confronti del quale tutti gli altri si
devono orientare.

Tenere premuto Shift al

momento di effettuare la selezione.

Seleziona oggetti nascosti

1. Premere2alt

2. Cliccare sull elemento e

della creazione.

muoverlo.
Seleziona tutti gli elementi di un‘immagine. Ctrl+A
Selezionare prossimo elemento nella successione Tab
della creazione.
Selezionare elemento precedente nella successione | Shift+Tab

POSIZIONARE

Spostare oggetto selezionato

Tasti con frecce

Spostare di 10 pixel per ogni pressione sul tasto con
frecce

Shift+Tasto freccia

Spostare solamente orizzontalmente oppure solo
verticalmente

Tenere premuto Shift al
momento di effettuare lo

Zzenon
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Centrare un oggetto selezionato nell’area di lavoro.

AZIONI

Comando

Salva modifiche.

Inserisce elemento proveniente dagli appunti

aggiunge elementi preso dagli appunti nella
posizione originale. Originale e copia sono
sovrapposti in modo perfetto.

Copia gli elementi selezionati

Copia invece che spostare

Cancella un elemento selezionato

Taglia un elemento selezionato

Annulla modifiche

Aggiungi o cancella nodo nell’elemento selezionato.
Aggiungi: il cursore del mouse diventa un segno
pulsante (+).

Cancella: il cursore del mouse diventa il segno meno

(-).
Funziona con polinea, poligoni e elementi tubature.

Termina disegno di polilinea e poligoni

Termina disegno di polilinea e poligoni e cancella
I’ultima area parziale disegnata

Colloca elementi selezionati al livello superiore

Colloca elementi selezionati al livello inferiore

spostamento.

H

Combinazione tasti
Ctrl+S

Ctrl+Vv
Shift+Ins

Ctrl+Shift+v

Ctrl+C
Ctrl+Ins

Tenere premuto Ctrlal momento
di effettuare lo spostamento.

Del
Shift+TCanc
Ctrl+X

Ctrl +Z
Alt+Backspace

Ctrl+Shift

Esc
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Superficie

Porta elementi selezionati in primo piano

Ctrl++

Porta elementi selezionati sullo sfondo

Ctrl+-

SCALARE

Modifica grandezza

Posizionare il cursore del mouse sul
punto di aggancio in modo tale che
esso prenda la forma di una freccia.
Poi, facendo uso dei tasti con
le frecce sipuo procedere a
stabilire la posizione con grande
precisione tenendo premuto il tasto
Shift in passidi10 pixel.

Indicazione: se, facendo uso della
proprietd Rotazione [°],sié
definito un angolo non uguale a O,
non e possibile scalare usando i
tasti con le frecce.

Scalare oggetto in riferimento al punto centrale:

Tenere premuto Al tal momento di
effettuare lo spostamento.

Scalare in modo proporzionale:

Tenere premuto Shift al
momento di scalare.

VISUALIZZAZIONE DETTAGLIATA

Crea nuovo elemento per il modulo relativo Ins.
Modifica la colonna selezionata F2
Copiare un elemento della lista selezionato Ctrl+C
Inserisce un elemento copiato in precedenza Ctrl+Vv
Cancellare un elemento della lista selezionato Del

Scrollare diversi elementi nella lista verso I'alto

Immagine su

Scrollare diversi elementi nella lista verso il basso

Immagine giu

Navigare nella lista

Tasti con frecce

Zzenon
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RUNTIME

Comando Combinazione tasti

Avwvia il Runtime; vengono creati i file Runtime F5
modificati in precedenza.

Crea i file runtime modificati E7

Sfoglia attraverso la finestra windows aperta Alt+Tab
Terminare il runtime Alt+F4
Aprire explorer con focus su cartella per i file Ctrl+Alt+D

runtime. Il progetto deve essere prima selezionato
nella struttura ad albero.

Aprire explorer con focus su cartella con il progetto Ctrl+Alt+R
runtime. Il progetto deve essere prima selezionato
nella struttura ad albero.

6. Barre dei simboli

Le barre simboli principali vengono posizionate nell’editor di defaullt sotto la Barra menu. Fatta
eccezione per la barra simboli ELementi; essa, infatti, viene visualizzata a destra accanto alla Finestra
principale. Se si muove il mouse su un simbolo, viene visualizzata nella barra di stato un’informazione
concernente la funzione del simbolo.

Le seguenti barre simboli principali sono disponibili:

» Finestra docking (auf Seite 31)

» Orientamento (auf Seite 31)

» Immagini (auf Seite 36) / Simboli (auf Seite 38)
» Profili editor (auf Seite 40)

» Elementi (auf Seite 41)

» Barra menu (auf Seite 38)

» Production & Facility Scheduler (auf Seite 43)
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» Trasporto remoto (auf Seite 45)

» Generatore di rapporti (auf Seite 47)
» File runtime (auf Seite 48)

» Livelli di visibilita (auf Seite 49)

» Macro VBA (auf Seite 50)

Le seguenti finestre dispongono di una barra simboli propria, che viene visualizzata sul margine
superiore della finestra stessa:

» Dettagli workspace (auf Seite 51)

» Proprieta (auf Seite 52)

¥ Informazioni

I titoli delle barra simboli corrispondono sempre alla lingua attiva nell editor al momento
in cui le barre stesse sono state aperte per la prima volta. Nel caso in cui, per esempio, la
barra simboli 'Immagini ' sia stata usata per la prima volta in tedesco, conserva il suo

nome anche se in seguito nell’editor si passa all inglese.

Se volete cambiare la lingua dei nomi, dovete anzitutto cancellare tutti i profili editor,

avviare I’editor nella lingua desiderata e poi attivare le barre dei simboli.

Non cancellate i profili editor in zenon, ma a livello dei file di sistema. (Dettagli su

questo tema li trovate nel capitolo Cancella profili editor (auf Seite 85).)

AZIONI CON SIMBOLI E BARRE SIMBOLI

Le opzioni per le barre simboli vengono impostate alla voce: Opzioni- > Impostazioni -> Tab Barra
simboli (auf Seite 77)

Azioni per barre simboli:

» posiziona liberamente sullo schermo
» Chiudi

» Apri

Azioni per simboli:

» Cancellare

28



» incolla

POSIZIONA BARRA SIMBOLI
1. Clliccate con il tasto sinistro del mouse in un settore libero della barra simboli.
2. Trascinate la barra simboli nella posizione desiderata dello schermo.
3. Unrettangolo sta ad indicare il posto nel quale la barra simboli verra inserita.

4. Rilasciate il tasto del mouse per posizionare la barra simboli.

Indicazione: barre simboli, che contengono liste a cascata, possono essere posizionate solo
orizzontalmente.

CHIUDI BARRA SIMBOLI

Potete chiudere delle barre simboli o tramite la lista a cascata opzioni, oppure con la Impostazioni
sotto opzioni.

LISTA A CASCATA: IL MODO PIU VELOCE PER CHIUDERE UNA BARRA
SIMBOLI.

1. Cliccate sulla lista a cascata Filtro
2. navigare per raggiungere la barra simboli
3. cliccate sull’inserimento relativo alla barra simboli da chiudere
IMPOSTAZIONI: CONSENTE DI CHIUDERE DIVERSE BARRE SIMBOLI
CONTEMPORANEAMENTE
1. apriteil menu Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 77)
2. Eliminate il segno di spuntatura accanto alla barra simboli desiderata.

3. confermate la selezione cliccando su ok

APRI BARRA SIMBOLI

Potete aprire delle barre simboli o tramite la lista a cascata opzioni, oppure conla Impostazioni
sotto opzioni.

29



LISTA A CASCATA: IL MODO PIU VELOCE PER APRIRE UNA BARRA SIMBOLI.
1. Cliccate sulla lista a cascata Filtro
2. navigare per raggiungere la barra simboli
3. cliccate sull’inserimento relativo alla barra simboli da aprire
IMPOSTAZIONI: CONSENTE DI APRIRE DIVERSE BARRE SIMBOLI
CONTEMPORANEAMENTE
1. apriteilmenu Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 77)
2. settate il segno di spuntatura accanto alla barra simboli desiderata.

3. confermate la selezione cliccando su ok

AGGIUNGI SIMBOLO

[y

aprite il menu Opzioni -> Impostazioni -> Tab: Comandi (auf Seite 75)
2. Selezionate nella finestra a sinistra una categoria.
3. Cliccate nella finestra di destra con il tasto sinistro del mouse sul simbolo desiderato.

4. tenendo premuto il tasto sinistro del mouse, trascinate il simbolo nella posizione desiderata

nella barra dei simboli

CANCELLA SIMBOLI

=

aprite il menu Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 77)
2. vengono attivati tutti i simboli di tutte le barre nell’editor
3. Cliccate con il tasto sinistro del mouse sul simbolo.

4. Trascinate il simbolo fuori dalla barra simboli e rilasciate il tasto del mouse.
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Barre dei simboli

Zzenon

6.1 Barra simboli Finestra docking

Le seguenti finestre nascoste oppure chiuse possono essere riattivate sempre con la barra simboli per

Finestre docking.

Finestre ancorabili [3|

BRES D

Manager di progetto Attiva il Manager di progetto.

Finestra di emissione Attiva la finestra di emissione.

Lista incrociata Attiva la lista riferimenti incrociati.
Finestra di proprieta Attiva la finestra di proprieta. .

Help proprieta Attiva la finestra della guida delle proprieta. .

Opzioni per barre dei | Cliccando sulla freccia si apre il sotto-menu:

simboli .
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si pud rendere attiva facendo uso
del menu Opzioni -> Barre dei simboli.

6.2 Barra simboli Orientamento

BEAFL (ke |MEME ENM VL Tk Byyg an o
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No.
01

02

03

04

05

06

07

08

09

10

11

12

Simbolo

orienta a sinistra

orienta a destra

orienta verso |'alto

orienta verso il basso

Centra orizzontalmente

Centra verticalmente

Stessa distanza X

Stessa distanza Y

Stessa distribuzione X:

Stessa distribuzione Y:

Stessa larghezza

Stessa altezza

Funzione

Orienta tutti gli elementi selezionati al margine sinistro
dell’elemento che é stato selezionato per primo.

Orienta tutti gli elementi selezionati al margine destro
dell’elemento che é stato selezionato per primo.

Orienta tutti gli elementi selezionati al margine superiore
dell’elemento che é stato selezionato per primo.

Orienta tutti gli elementi selezionati al margine inferiore
dell’elemento che é stato selezionato per primo.

Orienta |I’elemento selezionato al centro orizzontale
dell'immagine.

Nel caso in cui siano stati selezionati piu elementi, si orientano
tutti all’elemento che & stato selezionato per primo.

Orienta |I’elemento selezionato al centro verticale dell'immagine.

Nel caso in cui siano stati selezionati piu elementi, si orientano
tutti all’elemento che & stato selezionato per primo.

Allinea gli elementi selezionati nella successione della loro
selezione lungo I'asse x; i primi due elementi stabiliscono la
distanza.

Allinea gli elementi selezionati nella successione della loro
selezione lungo |"asse y; i primi due elementi stabiliscono la
distanza.

Distribuisce tutti gli elementi selezionati lungo I’asse x fra i due
elementi che sono stati selezionati per primi. Per questa opzione
devono essere selezionati almeno tre elementi.

Distribuisce tutti gli elementi selezionati lungo I’asse y fra i due
elementi che sono stati selezionati per primi. Per questa opzione
devono essere selezionati almeno tre elementi.

Gli elementi selezionati vengono adattati alla larghezza del primo
elemento selezionato.

Indicazione: Un adattamento si verifica sulla base delle coordinate
ottiche. Per i dettagli a questo proposito, vedi la spiegazione sotto
guesta tabella.

Gli elementi selezionati vengono adattati all’altezza del primo
elemento selezionato.
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13

14

15

16

17

18

19

20

21

22

23

24

25

26

Stesse dimensioni

In primo piano

Sposta avanti

Sposta indietro

Sullo sfondo

Specchia orizzontalmente
Specchia verticalmente
gira di 90°

Crea simbolo

Dividi simbolo

Modalita di modifica singola
simbolo / elemento

Aggiungi in simbolo esistente

Elimina da un simbolo.

Sostituisci collegamento

Indicazione: Un adattamento si verifica sulla base delle coordinate
ottiche. Per i dettagli a questo proposito, vedi la spiegazione sotto
questa tabella.

Gli elementi selezionati vengono adattati all’altezza e alla
larghezza del primo elemento selezionato.

Indicazione: Un adattamento si verifica sulla base delle coordinate
ottiche. Peri dettagli a questo proposito, vedi la spiegazione sotto
questa tabella.

Porta gli elementi selezionati in primo piano.

Porta gli elmenti selezionati avanti di un livello.

Porta gli elmenti selezionati indietro di un livello.

Porta gli elementi selezionati sullo sfondo.

Rispecchia I’elemento selezionato su un’asse orizzontale.
Rispecchia I'elemento selezionato su un’asse verticale.
Gira I’elemento selezionato di 90° in senso antiorario.
Crea un nuovo simbolo da tutti gli elementi selezionati.

Il simbolo viene diviso nei suoi elementi originari; il simbolo non
esiste pil.

Consente di modificare i singoli elementi di un simbolo. Il pulsante
fa passare tra modalita di editazione oggetti singola e modalita
editazione simbolo

Apre la barra dei simboli per aggiungere il simbolo attivo in un
simbolo della lista.

Elimina I’elemento selezionato dal simbolo attivo. Poil’'elemento
non appartiene piu al simbolo.

Apre il dialogo per sostituire delle variabili o funzioni
collegate con elementi dinamici. Dettagli: vedi capitolo
Sostituzione di variabili di processo in elementi
dinamici.Variabili di processo in elementi dinamici.

Variabili di processo in elementi dinamici.

Variabili di processo in elementi dinamici.
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27

28

Trasmetti proprieta

Opzioni per barre
dei simboli

Variabili di processo in elementi dinamici.

Variabili di processo in elementi dinamici.

Trasmette le proprieta di un elemento selezionato ad un
altro o a piu altri.

» Trasmettere ad un elemento:

cliccare su un elemento con proprieta originarie ->
cliccare sul simbolo Trasmetti proprieta -> cliccare
sull’elemento di destinazione: Le proprieta vengono
trasmesse.

» Trasmettere a piu elementi:

selezionare elemento fonte -> selezionare gli
elementi di destinazione tenendo premuto il tasto
Ctrl (sia I'elemento fonte che quelli di destinazione
sono evidenziati; quello fonte & caratterizzato anche
dalla presenza di punti di appiglio neri) -> cliccare
sul simboloTrasmetti proprieta. Le proprieta
dell’elemento fonte vengono trasmesse agli
elementi di destinazione.

Quali proprieta vengono trasmesse, dipende dall’oggetto fonte e
da quello di destinazione. Di norma, vengono trasmessi colori,
caratteri, allineamento paragrafo e bordi.

Se sono stati selezionati pil elementi come fonte, verranno
trasmesse le proprieta del primo elemento selezionato.

Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo
uso del menu Opzioni -> Barre dei simboli.

ADATTAMENTO STESSA LARGHEZZA/ALTEZZA/DIMENSIONE
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L’adattamento della dimensione di elementii ruotati e non ruotati fa riferimento alle coordinate ottiche,
non a quelle logiche. L’estensione di elementi ruotati viene intesa come superficie del rettangolo,
all'interno delle cui linee immaginarie si trova |’elemento ruotato (Bounding Rectangle).

AD ESEMPIO

Due elementi prima dell’adattamento:

o
Textvariable
£

Dopo I'adattamento tramite Stessa altezza:

Textvariable
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6.3 Barra simboli Immagini

Per la modifica delle immagini avete a disposizione una barra dei simboli apposita. Essa viene

visualizzata di dafault sotto la barra di menu.

@@ EE kg ) 2O
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Simbolo

(da sinistra a destra)
Salva immagine
Salva tutto

Taglia

Copiare

Incolla

Ridisegna

immagine

Modifica

Annulla

Zoom

Stampa

Guida

Funzione

Salva I'immagine attiva.
Salva tutte le immagini modificate.

Taglia I'elemento attivo e lo salva negli appunti, anche per piu progetti.
Disponibile solo se & stato selezionato un elemento.

Salva una copia dell'immagine attuale negli appunti. Disponibile solo se &
stato selezionato un elemento.

Aggiunge un’‘immmagine presa dagli appunti. Disponibile solamente se gli
appunti contengono dei dati.

Attualizza la visualizzazione dello schermo.

Passa dallo zoom alla modalita modifica.

Permette di annullare fino a 100 azioni. Di default possono essere annullate
fino a 10 azioni.

Definisci il numero delle azioni: Opzioni -> Impostazioni ->Impostazioni ->
Numero delle azioni annullate. Indicate un numero fra 1 e100.

Mette a disposizione due modalita di zoom:

> Zoom senza livelli:
Si puo inserire nel Combobox un valore qualsiasi compreso fra 15% e 400%,

oppure si puo scegliere un valore preimpostato.

> Zoomtool:
facendo uso dei simboli della lente di ingrandimento (+ e -) e possibile zoomare
direttamente nell'immagine servendosi del mouse. Premete il tasto Ctrl e
passate da una modalita allaltra. Il livello di zoom definito viene salvato per ogni

singola immagine.

Chiudi modalita zoom: cliccate sul simbolo Modifica. nella barra dei simboli
Elementi.

L'intero contenuto dello schermo viene stampato mediante la
stampante che é stata selezionata come standard. Proprieta di stampa
sotto File -> Configurazione generale -> Standard.

Apre la guida in linea.
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Opzioni per Cliccando sulla freccia si apre il sotto-menu:
barre dei
simboli attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso
del menu Opzioni -> Barre dei simboli.

6.4 Barra simboli Simboli

La libreria dei simboli vene gestita facendo uso del menu contestuale oppure della barra simboli:

F3 KL
e | & @

COMANDI NEL MENU CONTESTAULE E DELLA BARRA SIMBOLI.

Barra Menu contestuale Funzione

simboli

1 Nuovo simbolo Viene impostato un nuovo simbolo.

3 Apri simbolo Apre il simbolo nell’editor dei simboli per effettuare delle
modifiche.

2 Nuovo gruppo simboli | Vijene creato un nuovo gruppo simboli che pud essere riempito di

simboli selezionati della libreria, oppure con simboli crati ad hoc.
(Copiare ed inserire) Disponibile solo nella biblioteca di simboli
globale.

4 Inserisci simbolo Inserisce il simbolo nell'immagine in modalita scollegata.(per i

nell’immagine in dettagli vedi il sottocapitolo Simboli separati ).
modalita scollegata.

5 Inserisci simbolo Inserisci simbolo nell’'immagine in modalita collegata. (per i

nell ’:'“"f‘agine in dettagli vedi il sottocapitoloSimboli collegati).
modalita collegata.



13

14

10

11

12

15

16

18

19

17

Visualizzazione
piatta

Visualizzazione
gerarchica

Copiare

Incolla

Elimina

Modifica celle
selezionate

Sostituisci testo

nella cella
selezionata...

Proprieta

Ingrandisci / riduci
nodo

Esporta selezione in
XML

Importa XML..

Elimina tutti i
filtri

Guida

Opzioni per barre
dei simboli

Ordina tutti i imboli in una lista piatta. Semplifica la ricerca di un
determinato simbolo.

Indicazione: in questo tipo di visualizzazione non possono
essere né creati, né eliminati dei simboli; non e possibile neppure
copiare oppure aggiungere simboli provenienti dagli appunti.

Ordina tutti i simboli in modo gerarchico in sottogruppi e mostra
le relazioni di dipendenza.

Copia il simbolo selezionato negli appunti (solo nella
visualizzazione gerarchica).

Incolla il simbolo copiato nel gruppo attivo (solo nella
visualizzazione gerarchica).

Cancella il simbolo selezionato, oppure il gruppo di simboli (solo
nella visualizzazione gerarchica).

Attenzione: non si puo annullare la cancellazione!
Permette la modifica dei contenuti della cella selezionata.
Apre il dialogo che serve alla sostituzione automatica di testi

(disponibile solamente se sono selezionate delle celle che
possono contenetere del testo).

Apre la finestra Proprieta per il simbolo selezionato.

Nella visualizzazione gerarchica, permette di ingradire o ridurre il
nodo selezionato o tutti i nodi.

Apre il dialogo per I'export in formato XML dei simboli
selezionati. (Per i dettagli vedi capitolo Import / Export Simboli

Importa simboli da un file XML (vedi capitolo Import/Export
Simboli).

Elimina tutti i filtri settati nel titolo della colonna.

Apre la giuda in linea relativa al menu contestuale.

Torna indietro all’elemento di partenza (solo barra simboli).
Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva
facendo uso del menu Opzioni -> Barre dei simboli.
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6.5 Barra dei simboli Profili editor

| profili editor possono essere gestiti comodamente facendo uso della barra dei simboli corrispondente.
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Editorprofile

Carica profilo editor
selezionato

Barre dei simboli

Zzenon

Carica il profilo selezionato nel settore Seleziona profilo editor.

Seleziona profilo
editor

Lista a cascata (auf Seite 86) con 10 profili.

Carica profilo
standard

Resetta tutte le impostazioni relative a visualizzazione e posizione delle
finestre, nonché contenuti e visualizzazione delle barre dei simboli e dello
stato di emissione; poi carica il profilo standard di zenon.

Carica Profili
predefiniti: (auf Seite
78)

carica i profili predefiniti di COPA-DATA sui primi tre posti di memoria e li
collega ai moduli. Profili eventualmente gia esistenti vengono sovrascritti.

Elimina attribuzioni
di profili: (auf Seite 78)

Cancella tutti i collegamenti di profili predefiniti con i moduli.

Salvataggio automatico
dei profili editor

Attivo: le modifiche del profilo attuale vengono salvate
automaticamente al momento dell’apertura di un altro profilo.

Disattivato: le modifiche non vengono salvate al momento del
cambiamento di profilo; quando si richiama un’altra volta il profilo in
questione, vengono riproposte le posizioni originali.

Salva profilo editor
selezionato

Salva le impostazioni finestra attuali nel profilo che é visualizzato nel settore
Seleziona profilo editor.

Assegna nomi
individuali ai profili
editor.

Apre un Dialogo (auf Seite 86) in cui possono essere assegnati dei nomi
individuali ai profili editor.

Opzioni per barre
dei simboli

Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso del
menu Opzioni -> Barre dei simboli.

6.6

Barra dei simboli Elementi
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No.

01

02

03

04

05

06

07

08

10

09

11

12

13

14

15

16

17

18

19

20

21

Simbolo

Rettangolo
Linea

Rettangolo
arrotondato

Ellisse /
Cerchio

Poligono

Polilinea:

Curva

Segmento di
cerchio

Testo statico
Tubatura
Bargraf

Valore numerico
Testo dinamico
Elemento trend

Strumento
analogico:

Elemento di
stato

Pulsante
Interruttore

Multibin

Pulsante Allarmi
ad immagine

elemento di

Funzione

Con colore e tipo di linea e di riempimento;
larghezza, colore e tipo di linea definibile

Rettangolo con angoli arrotondati definibili liberamente.

Con colore e tipo di linea e riempimento

Con colore e tipo di linea e di riempimento;

Con tipo e colore della linea  (se descrive un’ area piana chiusa, anche
tipo e colore di riempimento)

larghezza, colore e tipo di linea definibile

disegna un segmento di cerchio con un angolo di apertura di 180°
(modificabile), spessore, colore e tipo della linea definibili.

Con colore e selezione del tipo di carattere
Con colore e tipo di linea e di riempimento;
Rappresentazione dei valori su un bargraf
Visualizzazione dei valori in forma numerica
Visualizza testi associati a valori limite
Visualizzazione semplice con grafica lineare

Visualizzazione valori in forma analogica

Riprendere i colori dalla progettazione dello stato delle variabili

zona di comando in rappresentazione di buttone

Semplice comando per I’ impostazione di valori limite

Rappresentazione di pil variabili di processo su un punto ad immagine con

colori e simboli

Disponibile solo con licenza per SICAM 230

Visualizzazione di testi da una tabella testi
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6.7

22

23

24

25

26

27

28

29

30

segnalazione
Orologio
Elemento comando

Elemento
combinato

Allarme ad
immagine

Elemento active
X

Slider
universale

Combo/ListBox
Elemento WPF
Modifica

Opzioni per
barre dei
simboli

Data ed ora
Disponibile solo con licenza per SICAM 230

Visualizza una o piu variabili su un unico punto d’ immagine con colori e
simboli (sequenza caratteri)

Disponibile solo con licenza per SICAM 230

Inserire elementi AktivX

Slider/potenziometro

Collega i valori di variabili con messaggi di testo.
Rappresenta file WPF-XAML validi.

Cambia da zoom a modalita di modifica
Cliccando sulla freccia si apre il sotto-menu:
attivo: viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si pud rendere attiva facendo uso del
menu Opzioni -> Barre dei simboli.

Barra dei simboli del Production and Facility Scheduler

I modulo Production Facility Scheduler puo essere modificato anche mediante una barra di simboli.

Producticn & Facility Scheduler

=

EEEEERTIEY
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Barre dei simboli

Zzenon

Rinomina Permette il cambiamento della denominazione di un impianto.
Proprieta Apre una finestra con le proprieta dell'impianto.
Elimina Elimina I'impianto selezionato dopo una conferma.

Ordina in andamento

crescente

Ordina la tabella/colonna selezionata in direzione crescente.

Ordina in andamento
decrescente

Ordina la tabella/colonna selezionata in direzione decrescente.

Cambia data

Apre il dialogo che serve ad inserire una data e cambia portandosi a
questa data.

Mostra oggi

Passa dalla data indicata alla data attuale.

Visualizzazione Mostra un giorno nel calendario.
giorno

Visualizzazione Mostra una settimana nel calendario.
settimana

Vista mensile

Mostra un mese nel calendario.

Elemento precedente.

Torna indietro nel calendario di un elemento in corrispondenza della
visualizzazione impostata (il che significa di un giorno, di una settimana
o di un mese).

Prossimo elemento

Va avanti nel calendario di un elemento in corrispondenza della
visualizzazione impostata (il che significa di un giorno, di una settimana
o di un mese).

Anteprima punti di
commutazione

Apre I'anteprima dei punti di commutazione.

Opzioni per barre dei
simboli

Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso
del menu Opzioni -> Barre dei simboli.
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6.8 Barra simboli Trasporto remoto

Un computer di sviluppo puo realizzare delle connessioni remote con altri calcolatori. La batta simboli
Trasporto remoto Mmette a disposizione delle funzioni che servono alla trasmissione e alla
interrogazione di dati.

B8 0y By 8 B8, Ry
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Trasporto remoto:
Crea collegamento

Barre dei simboli

Zzenon

Instaura un collegamento con il computer destinatario.

Trasporto remoto:
Impostazioni di

Apre il dialogo per la configurazione del collegamento.

collegamento

Remote: Trasmetti i Trasmette al computer di destinazione tutti i file runtime modificati sul
file runtime computer di sviluppo.

modificati

Remote: Rileggi tutti | Rilegge tuttiifile modificabili nel runtime (come ricette, oppure

i file runtime gestione user) sul computer di sviluppo.

modificati

Remote: Imposta Setta il progetto di partenza per il computer di destinazione.

progetto di partenza

Remote: Lanciare Awvia il runtime sul computer di destinazione.
runtime

Remote: Terminare il Chiude il runtime sul computer di destinazione.
runtime

Remote: Aggiorna
progetto

Esegue sul computer di destinazione la funzione aggiorna.

Remote: Avvia
connessione con il

desktop

Awvia un collegamento che serve a consentire la gestione del computer
di destinazione via Remote Desktop.

Opzioni per barre dei
simboli

Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso
del menu Opzioni -> Barre dei simboli.

Ulteriori simboli possono essere
aggiunti facendo uso di Opzioni
della barra simboli (auf Seite 75):

Trasmetti tutti i
file runtime.

Trasmette tutti i file Runtime al sistema di destinazione.

Riavvia il sistema

Riavvia il sistema operativo del computer di destinazione dopo aver
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operativo effettuato un controllo di sicurezza. Questa opzione non viene
supportata con Windows CE.

Rileva lo stato di Rileva lo stato del sistema del computer di destinazione e scrive i dati
sistema nella finestra di emissione. Il sistema rileva quanto segue:

»  Nome computer

> Sistema operativo

»  Runtime attivo/non attivo

»  Progetto di partenza

»  Memoria reale

> Processori

»  Numero di serie remoto

»  Numero di attivazione remoto

» laversione remota di zenon
Modifica password e Apre Dialogo per connessione.

mostra licenza
Consente:

»  Modifica della password per la connessione
> Visualizzazione e modifica della licenza del calcolatore di destinazione

»  Configurazione della Crittografia sul calcolatore di destinazione

Indicazione: tutti i comandi per il trasporto remoto sono a disposizione anche nel Menu contestuale
del progetto.

6.9 Barra simboli del Generatore di rapporti

Per il generatore di rapporti avete a disposizione una barra di simboli nell’editor: nel caso in cui non
dovesse essere visibile, la si pud visualizzare mediante:

1. apriteil menu Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 77)

2. attivate il checkbox accanto al Generatore di rapporti
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Barre dei simboli

Zenon
3. confermate la selezione cliccando su ok
Stampa report Stampa il rapporto con la stampante impostata come standard.
Anteprima pagina Apre il rapporto in un“anteprima. Il rapporto puo essere ingrandito oppure
report rimpicciolito (zoom); lo si puo sfogliare e stampare.
Ridisegna report Attualizza la visualizzazione.

Ricalcola funzioni | Calcola nuovamente le formule nel report

Assistente Apre un dialogo che serve di aiuto per la configurazione delle funzioni.
funzione
Carattere Apre un dialogo che serve alla formattazione delle celle con attenzione

particolare al tab Carattere.

orientamento testo | Apreun dialogo che serve alla formattazione delle celle con attenzione
particolare al tab Orientamento.

Cornice Apre un dialogo che serve alla formattazione delle celle con attenzione
particolare al tab Cornice.

Disegno Apre un dialogo che serve alla formattazione delle celle con attenzione
particolare al tab Disegno.

Opzioni per barre Cliccando sulla freccia si apre il sotto-menu:

dei simboli .
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso del
menu Opzioni -> Barre dei simboli.

6.10 Barra simboli File runtime

Per trasferire dei file dall’editor al runtime, oppure viceversa, avete a disposizione una barra di simboli:
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Simbolo Funzione

(da sinistra a destra)

Crea 1 file runtime Crea file runtime di tutti i file modificati nell’editor. Scegliete nel menu
modificati dropdown se i file runtime devono essere generati solo per il progetto
attivo, o per tutti i progetti caricati.

Crea tutti 1 file Crea file runtime per tutti i file esistenti nell’editor. Scegliete nel menu
runtime dropdown se i file runtime devono essere generati solo per il progetto
attivo, o per tutti i progetti caricati.

Importa 1 file | file modificabili nel runtime (come ricette oppure gestione utenti)
runtime vengono riletti dal runtime nell’editor.

Runtime: file Apre il Dialogo che serve alla gestione dei file modificabili durante il
modificabili Runtime.

Lanciare runtime Avwvia il runtime.

Opzioni per barre Cliccando sulla freccia si apre il sotto-menu:

dei simboli
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso
del menu Opzioni -> Barre dei simboli.

6.11 Barra simboli Livelli di visibilita

In modo simile a quanto accade nei programmi CAD, si possono definire nell’editor dei livelli di visibilita,
che possono essere assegnati poi a singoli elementi. In tal modo & possibile nascondere nel caso di
immagini complesse quegli elementi che non sono necessari, che poi, pero, possono essere resi di nuovo
visibili in qualsiasi momento. Sono a disposizione ben 15 livelli di visibilita. L attribuzione di un livello
viene effettutata nella proprieta Livello di visibilita nel nodoGenerale. Lattivazioneo la
disattivazione dei singoli livelli avviene facendo uso dei pulsanti della barra simboli Livelli di

visibilita:

"Livelli di visibilita
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Mostra tutti 1 livelli di
visibilita

Barre dei simboli

Visualizza tutti i livelli.

Zzenon

Nascondi tutti i livelli
di visibilita

Nasconde tutti i livelli.

Livello di visibilita<Nr>

Mostra o nasconde il livello di visibilita corrispondente.

Opzioni per barre dei
simboli

Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si pud rendere attiva
facendo uso del menu Opzioni -> Barre dei simboli.

¥ Informazioni

I livelli di visibilita valgono solamente per |'Editor e non hanno alcun influsso sul Runtime.

Indicazioni sugli elementi di controllo: gli elementi di controllo vengono visualizzati nel

Runtime sempre al primo posto. Cio vale anche quando essi vengono coperti da altri

elementi nell’Editor. In tal modo si vuole garantire che essi siano sempre raggiungibili.

6.12 Barra dei simboli delle Macro VBA

Le macro che sono state realizzate usando VBA, possono essere gestite tramite la barra simboli vea.
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Simbolo

(da sinistra a destra)

Ricarica la lista
delle macro VBA.

Lista dropdown Macro

Esegui le macro
selezionate.

Esegui la macro x

assegnata. #<x>

Assegna macro

Opzioni per barre dei

Funzione

Carica tutte le macropublic Sub Name () contenutein

myWorkspace e nei moduli nella lista dropdown della barra
simboli.

Contiene tutte le macro caricate e ne permette la selezione.

Esegue la macro selezionata nella lista a cascata (dropdown).

Esegue la macro assegnata al simbolo.

Apre il dialogo che serve all’assegnazione di macro. Con i simboli

possono essere collegate da 1 a 5 macro.

Cliccando sulla freccia si apre il sotto-menu:

simboli
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso
del menu Opzioni -> Barre dei simboli.

¥ Informazioni

Nel caso in cui nel dialogo di attribuzione non vengano offerte tutte la macro
contenute in myWorkspace, eseguite nella barra dei simboli la funzioneRicarica la
lista delle macro VBA.

6.13 Barra dei simboli della sezione lista

Nella visualizzazione dettagliata del Manager di progetto vengono visualizzate le barre dei simboli
relative al tipo di nodo attivato. Queste ultime corrispondono al contenuto del menu contestuale
corrispondente. La guida relativa alle singole barre dei simboli la trovate nel capitolo corrispondente
per esempio: Variabili Visualizzazione dettagliata Barra simboli

’
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6.14 Barra dei simboli Proprieta

Le proprieta di un oggetto vengono visualizzate e modificate nella finestra delle proprieta. Per
organizzare la finestra delle porprieta e a Vostra disposizione una barra di simboli:

EE =N N == a e |
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Simbolo

(da sinistra a destra)
Gruppi di

rappresentazione
(auf Seite 141)

(default)

Tutte le
proprieta
Seite 143)

(auf

Vista a dialogo
(auf Seite 142)

Mostra/nascondi i
favoriti (auf Seite 143)

Mostra/nascondi
tutte le
proprieta

Ordinamento
logico

(default)

Ordinamento
crescente e
decrescente

Funzione

Tutte le proprieta dell oggetto selezionato vengono raggruppate secondo
un criterio logico e i gruppi vengono ordinati o in ordine alfabetico
oppure in modo logico. Attraverso il menu contestuale possono essere
aggiunti o eliminati inserimenti dai Favoriti.

Standard per il manuale: le indicazioni del manuale sulle proprieta
partono sempre dalla visualizzazione a gruppi. | contenuti dei gruppi
corrispondono quellidella Visuale a dialogo.

Tutte le proprieta dell'oggetto selezionato vengono rappresentate in una
lista. Attraverso il menu contestuale possono essere aggiunti o eliminati
inserimenti dai Favoriti.

Tutte le proprieta vengono riassunte in modo logico come nei Gruppi
di rappresentazione eigruppisono ordinati secondo la
frequenza e la priorita del loro uso. In questa visualizzazione non
possono essere definiti dei favoriti.

Mostra o nascondo nelle visuali Gruppi di rappresentazione
oppure Tutte le proprieta il nodo Favoriti.In esso sono raccolte
quelle proprieta che vengono utilizzate piu frequentemente.

Di default vengono proposti dei favoriti.

Aggiungi o cancella dai favoriti degli inserimenti: Cio accade mediante il
menu contestuale 'Aggiungi ai favoriti', 0 mediante Drag&Drop
delle proprieta nella lista dei favoriti.

La successione delle proprieta nei favoriti viene definita dal criterio di
classificazione prescelto (ordine crescente, decrescente, logico).

Nellavisuale di dialogo non possono essere creati dei favoriti.

Mostra o nasconde tutti i nodi nelle visuali Raggruppato e Tutte le
proprieta

Mostra nelle visuali Raggruppatoe Tutte le proprieta le proprieta
ordinate in modo logico secondo la frequenza d’uso invece che in ordine
alfabetico.

Mostra nelle visuali Raggruppatoe Tutte le proprieta le proprieta
ordinate in ordine alfabetico crescente o decrescente.
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Apri/chiudi tutti
i nodi

Mostra guida
delle proprieta
(auf Seite 145)

Rendi disponibili
proprieta

Opzioni per barre
dei simboli

7. Barra menu

La barra menu contiene (a seconda del modulo ed elemento selezionati) liste a cascata per i seguenti

elementi.

BASE

File Modifica Opzioni Finestra Guida
» File
» Modifica

» Immagini

» Opzioni
» Finestra
» Guida

Apre o chiude nelle visuali Raggruppato e Tutte le proprietatuttii
nodi.

Eccezione: il nodo delle proprieta attualmente selezionate rimane
aperto cliccando su Chiudi tutti i nodi.

Mostra la guida integrata che concerne le proprieta (guida delle
proprieta).

Simboli: rende disponibile la Proprieta selezionata.

Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso
del menu Opzioni -> Barre dei simboli.
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IMMAGINI E SIMBOLI

Non appena viene aperta un’immagine, nuovi punti di menu completano la barra:

File Edit Screens Elements Control elements Options Window Help

» Elementi

» Elementi di controllo

Se viene attivata la Libreria simboli globale, il punto menu immagini viene sostituito da simboli.

REPORT

File Modifica Report Formato Opzioni Finestra Guida
Se si apre un Rapporto:

» il menu Immagini viene sostituito da Report
» viene inoltre aggiunto il menu Formato

» icomandi del menu Modifica (auf Seite 58) vengono sostituiti

7.1 File

Sono disponibili le seguenti azioni:
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Punto di menu Azione

Progetto Apre il dialogo che serve a creare un nuovo progetto.

Inserisci progetto Apre il dialogo che serve ad inserire un progetto esistente nell’editor.

esistente

Inserisci progetto Apre il dialogo che serve ad inserire un progetto realizzato con |'editor

5.50 della versione 5.50.

Ripristino di backup Apre il dialogo che serve a caricare lo stato di un progetto salvato in un

di progetto backup

Area di lavoro

(Workspace)

nuovo Apre il dialogo che serve a creare un nuovo workspace.

Apri Apre il dialogo che serve a caricare un workspace gia esistente.

Salva Salva I'area di lavoro corrente.

Salva con nome.. Salva l'attuale workspace. Potete indicare il nome e il luogo in cui
effettuare il salvataggio.

Chiudi Chiudi I'attuale area di lavoro.

Crea backup Apre il dialogo che serve a salvare tutti i progetti del worspace attuale. |l
backup viene salvato in un file compresso *.wsb.

Ripristina backup Apre il dialogo che serve a caricare i progetti salvati in un backup del
wokspace.

Configurazione

generale

Registrazione prodotto | Apreiil dialogo Registrazione del prodotto che serve all’inserimento del
numero di serie e di quello di attivazione, oppure a richidere una licenza
soft.

Standard Apre il dialogo che serve alla Configurazione delle impostazioni standard
per i luoghiin cui salvare i dati e per le stampanti

> AML

> CEL:



Pannello di controllo

Stampa Screenshot

Editor Visual Basic

Wizard

Aggiornamento Wizards

Workspace esistenti

Chiudi

> Valori
> Protocolli
> Screenshots

> Blocco note
Apre il pannello di controllo del sistema operativo.

L'intero contenuto dello schermo viene stampato mediante la stampata
che e stata selezionata come standard. Proprieta di stampa sotto File ->
Configurazione generale -> Standard. In un sistema a piu monitor, viene
stampato sempre lo schermo 1.

Apre I'editor di Visual Basic

Informazione: questo punto di menu esiste solamente se avete attivato
VBA VSTA nel file zenon6.ini. Attivate VBA assicurandovi che nel settore
[VBA] sia presente I'inserimento EIN=1.

Apre il dialogo che serve alla selezione di un assistente.

Informazione: questo punto di menu esiste solamente se avete attivato
VBA VSTA nel file zenon6.ini. Attivate VBA assicurandovi che nel settore
[VBA] sia presente I'inserimento EIN=1.

Apre il dialogo che serve ad effettuare I"'update di un wizard. | dettagli li
trovate nel capitolo Wizard, capitolo Update dei wizard.

Informazione: questo punto di menu esiste solamente se avete attivato
VBA VSTA nel file zenoné6.ini. Attivate VBA assicurandovi che nel settore
[VBA] sia presente I'inserimento EIN=1.

Presenta una lista dei workspace esistenti. Vengono indicati gli ultimi 5
workspace selezionati.

Chiude I’editor di zenon.
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7.2 Modifica

IMMAGINI E SIMBOLI

Se si seleziona un‘immagine o un simbolo, il menu Modifica mette a disposizione dell’utente delle
funzioni speciali.

Sono disponibili le seguenti azioni:

Punto di menu

Annulla

Taglia
Copiare

Incolla

Inserisci nella
stessa posizione

Elimina

Seleziona tutto

Proprieta

Sostituisci
collegamento

Posizione elemento

Azione

Annulla l'ultima azione.

Il numero delle azioni che & possibile annullare viene definito
alla voce Opzioni -> Impostazioni .

Attenzione: Nell’editor dei modelli non & possibile annullare
delle azioni.

Taglia I'oggetto selezionato e lo salva negli appunti.
Taglia I'oggetto selezionato e lo salva negli appunti.

Incolla un oggetto tagliato o copiato negli Appunti. Gli elementi
vengono inseriti sempre centrati nella sezione di lavoro. Nel
caso ci siano diversi oggetti, la posizione reciproca degli oggetti
rimane la stessa.

La copia dell’'oggetto viene incollata nella stessa posizinoe come
nell originale.

Elimina I'oggetto selezionato.
Seleziona tutti gli oggetti nella finestra principale.

Attiva la finestra di proprieta. .

Apre il dialogo per sostituire delle variabili o funzioni collegate
con elementi dinamici. Dettagli: vedi capitolo Sostituzione di
variabili di processo in elementi dinamici.

Modifica la posizione degli elementi selezionati.

Tasto ALT+ clic con il tasto sinistro del mouse
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Primo piano
Sfondo
avanti:
indietro:
Allinea

A sinistra
A destra

Su

Giu

Ordina

seleziona elmenti da livelli inferiori.

Porta gli elementi selezionati in primo piano.

Porta gli elementi selezionati sullo sfondo.

Porta gli elmenti selezionati avanti di un livello.
Porta gli elmenti selezionati indietro di un livello.
Riposiziona gli elementi selezionati.

Gli elementi selezionati vengono allineati a sinistra.
Gli elementi selezionati vengono allineati a destra.
Gli elementi selezionati vengono allineati in alto.
Gli elementi selezionati vengono allineati in basso.

Riordina elementi. Punto di riferimento & il primo elemento
selezionato.
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Stessa larghezza

Stessa altezza

Stesse dimensioni

Centra
orizzontalmente

Centra
verticalmente

Stessa distanza X

Stessa distanza Y

Stessa
distribuzione X:

Stessa
distribuzione Y:

Gli elementi selezionati vengono adattati alla larghezza del
primo elemento selezionato.

Indicazione: nel caso di elementi ruotati, la larghezza si orienta
sempre alle coordinate ottiche, non a quelle logiche. Peri
dettagli vedi capitolo Barra simboli Orientamento (auf Seite 31).

Gli elementi selezionati vengono adattati all’altezza del primo
elemento selezionato.

Indicazione: nel caso di elementi ruotati, I'altezza si orienta
sempre alle coordinate ottiche, non a quelle logiche. Peri
dettagli vedi capitolo Barra simboli Orientamento (auf Seite 31).

Gli elementi selezionati vengono adattati all’altezza e alla
larghezza del primo elemento selezionato.

Indicazione: nel caso di elementi ruotati, la grandezza si orienta
sempre alle coordinate ottiche, non a quelle logiche. Peri
dettagli vedi capitolo Barra simboli Orientamento (auf Seite 31).

Gli elementi selezionati vengono allineati orizzontalmente al
centro del primo elemento selezionato.

Gli elementi selezionati vengono allineati verticalmente al centro
del primo elemento selezionato.

Gli elementi selezionati vengono ordinati in modo tale che la
distanza fra di loro sull’asse X sia uguale; i primi due elementi
determinano la distanza.

Gli elementi selezionati vengono ordinati in modo tale che la
distanza fra di loro sull’asse Y sia uguale; i primi due elementi
determinano la distanza.

Distribuisce tutti gli elementi selezionati lungo I'asse x fra i due
elementi che sono stati selezionati per primi. Per questa
opzione devono essere selezionati almeno tre elementi.

Distribuisce tutti gli elementi selezionati lungo I’asse y fra i due
elementi che sono stati selezionati per primi. Per questa
opzione devono essere selezionati almeno tre elementi.
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Specchia
orizzontalmente

Specchia
verticalmente

Gira 90°

Ordine tastiera
sinistra/destra

Ordine tastiera
su/giu

Simbolo

Crea simbolo

Dividi simbolo

Modalita di
modifica singola

simbolo / elemento

Incolla nel simbolo

esistente.

Elimina da un
simbolo.

Converti il simbolo

collegato in uno
non collegato

Lista simboli

Sposta successione

per focus.

Rispecchia |I'elemento selezionato su un’asse orizzontale.

Rispecchia I'elemento selezionato su un’asse verticale.

Gira I’elemento selezionato di 90° in senso antiorario.

Mostra un modello con il quale viene stabilita la successione
orizzontale nella quale si passa agli elementi ad immagine
mediante la funzionesetta focus.

Mostra un modello con il quale viene stabilita la successione
verticale nella quale si passa agli elementi ad immagine
mediante la funzionesetta focus.

Crea un nuovo simbolo da tutti gli elementi selezionati.

Il simbolo viene diviso nei suoi elementi originari; il simbolo non
esiste piu.

Consente di modificare i singoli elementi di un simbolo. Passa
tra modalita di editazione oggetti singola e modalita editazione
simbolo

Apre la barra dei simboli per aggiungere il simbolo attivo in un
simbolo della lista.

Elimina I'elemento selezionato dal simbolo attivo. Poi
I’elemento non appartiene pil al simbolo.

Converte un simbolo da collegato a uno non collegato. |
simbolo perde, dunque, il suo collegamento con quello originale
nella libreria e puo essere modificato solo localmente. Questa
conversione non puo essere annullata.

Apre una lista di tutti i simboli che sono visualizzati
nell'immagine attuale. Per ogni simbolo vengono indicate in una
lista le sue singole componenti grafiche.

Apre la lista dropdown che serve a stabilire la successione
orizzontale o verticale per la Gestione tastiera.
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Successione per Stabilisce la successione orizzontale.
sinistra/destra

Successione per Stabilisce la successione verticale.
sopra/sotto

RAPPORTI

Per i Rapporti, il menu Modifica mette a disposizione i seguenti inserimenti:

Comando Descrizione

Taglia Taglia I’area evidenziata e la copia negli appunti.

Copiare Aggiunge il contenuto degli appunti.

Incolla Copia I’area evidenziata negli appunti.

Inserisci esteso Mette a disposizione delle opzioni di inserimento estese per operazioni
cella:

> tutto Inserisce tutto quanto contenuto negli appunti.

) Formule Inserisce solamente formule

» Valore Inserisce solamente valori Va perso il riferimento alle formule.

) Formato Riprende solamente il formato.

Riempire Copia il contenuto della prima cella di una selezione e lo trasferisce in tutte
le altre celle.

> In giu Il iempimento avviene dall’alto in basso.

> a destra Il iempimento avviene verso destra.

Rimuovi Cancella dalle celle selezionate:

> tutto tutto

» Contenuto Solo contenuti.

» Formato Solo formati.
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Cancella colonna/riga

Inserisci colonna/riga

Cerca/Sostituisci

7.3

Cancella le colonne o le righe selezionate.

Inserisce nuove colonne o righe. L'inserimento avviene sopra larigao a
destra della colonna. Viene aggiunto un numero di righe/colonne pari a
quello evidenziato nel foglio elettronico.

Apre il Dialogo che serve alla ricerca e sostituzione nel foglio elettronico.

Immagini

Sono disponibili le seguenti azioni:

Punto di menu

Salva immagine

Salva tutte le
immagini

Ridisegna immagine
Mostra la griglia:

Utilizza griglia

Usa punti di appiglio

Zoom

Stampa screenshot
dell'immagine
attuale.

Inserisci grafica
vettoriale

Azione

Salva I'immagine attuale.

Salva tutte le immagini.

Attualizza la visualizzazione dello schermo.

Visualizza o nasconde la griglia.

Visualizza o nasconde la griglia.

On: Tutti gli oggetti vengono allineati automaticamente alla griglia.
Attiva o disattiva i punti di appiglio

Usa: se si avvicina un oggetto al punto di appiglio di un altro oggetti, I'oggetto si
aggancia a questo punto di appiglio.

Modifica la grandezza della visualizzazione in percentuali definite fra 15 % e 400
%.

L'immagine attuale viene stampata mediante la stampante che é stata
selezionata come standard. Proprieta di stampa sotto File -> Configurazione
generale -> Standard.

Apre il dialogo che serve ad inserire una grafica vettoriale esterna.
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¥ Informazioni

Non appena e attivo un elemento ad immagine, viene visualizzato il menu Elementi.
Esso mette a disposizione dell utente tutti gli Elementi vettoriali e gli Elementi
dinamici in modo analogo alla barra dei simboli Elementi. Se si selezionano degli
speciali Tipi d'immagine, viene visualizzato anche il menu Elementi di controllo.
Questo menu mette a disposizione dell’utente quegli elementi di controllo che sono

relativi al tipo d'immagine selezionato.

7.4 Simbolo

Sono disponibili le seguenti azioni:
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Punto di menu

Salva simbolo
Salva tutti i simboli

Modifica grandezza
simbolo / colore di
sfondo

Lista simboli

Modalita schermo
intero

Ridisegna simbolo

Mostra la griglia:

Utilizza griglia

Usa punti di appiglio

Sposta successione per
focus.

Azione

Salva il simbolo attuale.

Salva tutti simboli.

Apre il dialogo per la configurazione della grandezza simbolo e del

colore di sfondo.

Indicazione: le modifiche del colore di sfondo riguardano
sempre tutti i simboli nella libreria simboli globale.

Apre una lista di tutti i simboli che sono visualizzati
nell'immagine attuale. Per ogni simbolo vengono indicate
in una lista le sue singole componenti grafiche.

La modalita schermo intero esclude tutte le altre finestre e
mostra solamente quella principale con tutti i documenti aperti
(immagini, rapporti ....) in forma di immagine piena che occupa
tutto lo schermo.

La modalita schermo intero pud essere terminata tramite:

» il pulsante visualizzato per chiudere la modalita

schermo intero
» lacombinazione tasti Shift +F9

» iltastoEsc

Attualizza la visualizzazione dello schermo.

Visualizza o nasconde la griglia.
Visualizza o nasconde la griglia.

on: Tutti gli oggetti vengono allineati automaticamente alla
griglia.

Attiva o disattiva i punti di appiglio

Usa: se si avvicina un oggetto al punto di appiglio di un altro
oggetti, I'oggetto si aggancia a questo punto di appiglio.

Apre la lista dropdown che serve a stabilire la successione
orizzontale o verticale per la Gestione tastiera.

Successione per sinistra/destra: Stabilisce la
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Zoom

Stampa screenshot del
simbolo attuale.

Inserisci grafica
vettoriale

7.5 Finestra

Sono disponibili le seguenti azioni:

successione orizzontale.

Successione per sopra/sotto: Stabiliscela
successione verticale.

Modifica la grandezza della visualizzazione in percentuali definite
fra 15 % e 400 %.

Il simbolo attuale viene stampata mediante la stampante che &
stata selezionata come standard. Proprieta di stampa sotto File -
> Configurazione generale -> Standard.

Apre il dialogo che serve ad inserire una grafica vettoriale
esterna.
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Punto di menu

Modalita schermo
intero

Chiudi
Dividi
Lista delle
finestre

Finestra

7.6 Guida

Azione

La modalita schermo intero esclude tutte le altre finestre e mostra solamente
quella principale con tutti i documenti aperti (immagini, rapporti ....) in forma
di immagine piena che occupa tutto lo schermo.

La modalita schermo intero puo essere terminata tramite:
» il pulsante visualizzato per chiudere la modalita schermo intero
» la combinazione tasti Shift +F9

» iltastoEsc

Chiudi la finestra attiva.

Suddivide la finestra principale e ordina le finestre attive in modo
corrispondente.

Mostra le finestre aperte. Al massimo vengono inserite nella lista 9 finestre.

Apre il dialogo che serve a gestire le finestre in quella principale:
» attivare
» salvare (possibile un multiselect)

» chiudere (possibile un multiselect)

La finestra attiva verra preselezionata.

Sono disponibili le seguenti azioni:
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Informazioni su

Barra menu

Aprite una finestra con informazioni su zenon:
> Numero di serie

> Numero di attivazione

»  Tags/|Os con licenza

> moduli con licenza

Potete navigare all’interno della finestra-info servendovi di una barra di
scorrimento. Cliccando all’interno della finestra o premendo il tasto Esc si

esce dalla finestra-info.

Zzenon

Getting Started

Apre il capitolo Tutorials della guida in linea

Guida

Richiama la guida in linea

7.7

Opzioni

Sono disponibili le seguenti azioni:
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Punto di menu Azione

Impostazioni Apre il dialogo che serve alla configurazione delle Impostazioni
generali (auf Seite 70), Menu (auf Seite 73), Barra simboli (auf Seite
77) e Comandi (auf Seite 75).

Editor Gestire profili Apre il Sottomenu (auf Seite 83) che serve alla gestione dei profili
editor editor.

Finestra principale con Mostra o nasconde nella finestra principale la visuale immagine
schede

multipla facendo uso di schede.

Riga di stato Mostra o nasconde la Barra di stato dell’Editor. Essa non &
identica alla barra di stato della visualizzazione dettagliata (auf
Seite 89) del Manager di progetto.

Manager di progetto Mostra la finestra Manager di progetto (auf Seite 86).
Finestra di emissione Mostra la finestra Finestra di emissione (auf Seite 146).
Lista incrociata Mostra la Lista riferimenti incrociati

Finestra di Proprieta Mostra la finestra Finestra di proprieta (auf Seite 138).
Help proprieta Mostra la finestra con la Guida delle proprieta (auf Seite 145).
Barre dei simboli Lista a cascata per visualizzare/escludere le barre simboli.

Update del Runtime Windows | Apre il software che serve per |'update di un runtime Windows CE.
CE

Definisci nuovo inserimento | Apre il dialogo per implementare programmi esterni come propri
menu

inserimenti menu.

Un consiglio: nel caso in cui sia gia stato impostato un ulteriore
inserimento di menu, quest’ultimo viene visualizzato in questa
sede. Nuovi e ulteriori inserimenti menu vengono creati alla voce
Opzioni -> Impostazioni -> Menu Tools (auf Seite 73).



7.7.1 Impostazioni

Nel dialogo Impostazioni potete fissare le impostazioni di base per zenon.

Impostazioni @
Impostazioni |Menu toals I Farbschema I Comandi I Toolbar|
Editor e Runtime Impostazioni griglia
Lingua selezionata [ Mostra griglia
Col il i il
Cornice per gli elementi dinamici e 2UEE |.a -
Mell'Editor [ Nel Runtime -l
[~ Non inviare segnalazione di errori a Microsoft Spaziatura griglia [Pixel]
Orizzontale Verticale
Opzioni Editor 10 10
Carica ['ulimo Workspace attivo
[T Filtro nella lista dettagliata Case Sensitive
Ordinamento logico dei testi in visualizzazione dettagli Punti di ancoraggio
Utilizza Assistenti di configurazione Utilizza ancoraggio tra elementi vicini
Dimensione punti di ancoraggio per le immagini
Modifica immagine 15
| Immissi tri all i
rpmlssmlne pfan.amfa =l creaz.:on? . X Dimensione punti di selezione nellEditor dei modelli
Dialogo 'Sostituisd collegamenti' allinserimento del simbolo p
Distanza pixel prima del cambio di posizione
5
Punti di selezione
Numero di operazioni annullabil [T tnverti sfondo
10 Dimensione punti di selezione
5
oK ] [ Abbrechen

Opzioni

Editor e Runtime

Lingua selezionata

Cornice di
elementi dinamici

Non inviare

rapporto di errore
e Microsoft.

Editor Opzioni

Caricare 1l’'ultimo
workspace attivo:

Azione

Scegliete la lingua per la superficie dell’editor. Per effettuare un
cambio di lingua, I'editor deve essere riavviato. La lingua standard
dell’editor e I'inglese.

Attivo: rappresenta gli elementi dinamici con una cornice di
posizione. Potete differenziare fra editor e runtime.

Attivo: impedisce in caso diinterruzione del funzionamento del
programma |’invio di un rapporto di errore a Microsoft.

Attivo: all’avvio dell’editor verranno caricate le ultime aree di
lavoro attive, visualizzate in una struttura ad albero. (Default)
Non attiwvo: all’avvio dell’editor non viene caricato nessun
workspace. Facendo uso del menu contestuale, potete aprire dei
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Filtro nella
visualizzazione

dettagliata tiene

conto della
scrittura
maiuscole /
minuscola.

Classificazione
logica di testi
nella sezione

lista

Usa assistente

Modifica immagini

Apri proprieta
oggetto
automaticamente

Dialogo "Adatta

collegamenti" per

1l inserimento di
simboli.

Distanza in pixel

perché si
verifichi un
cambiamento di
posizione.

Quantita di azioni

annullabili

Griglia Impostazioni

progetti e workspace esistenti, oppure ne se puo creare degli altri.

Attivo: ilfiltro nella visualizzazione a lista distingue fra lettere
maiuscole e minuscole.

Non attivo: ilfiltro nella visualizzazione a lista considera allo
stesso modo lettere maiuscole e minuscole (Default).

Attivo: nomifile contenenti numeri vengono ordinati secondo un
criterio logico nella visualizzazione a lista, per es. 1, 2, 10, 11
Inattivo: nomifile contenenti numeri vengono ordinati secondo
un criterio alfabetico nella visualizzazione a lista, per es. 1, 10, 11, 2

Attivo: quando sivuole creare degli Archivi, Elementi
combinati e Slider universale, il sistema offre automaticamente
I"aiuto di un assistente.

Disattivato: Archivi, Elementi combinati e Slider
universale vengono configurati manualmente.

Attivo: Secreate un elemento dinamico, si aprono
automaticamente i box di dialogo per le impostazioni dettagli, come,
ad esempio, quello che serve alla selezione delle variabil
Disattivato: L’elemento dinamico viene disegnato, mentre le
sue proprieta devono essere definite separatamente.

Attivo: Quando siinserisce un simbolo in un‘immagine, si apre il
dialogo Adatta collegamenti.

Disattivato: Il dialogo non viene aperto. Dei collegamenti
possono essere sostituiti in qualsiasi momento facendo uso del
comando Sostituisci collegamenti che potete trovare nel menu
contestuale.

Intende evitare uno spostamento involontario di elementi. Prima che
un elemento venga effettivamente spostato, esso deve essere mosso
perlomento per uno spazio che corrisponde al numero di pixel indicato.

Permette di annullare fino a 100 azioni. Di default possono essere
annullate fino a 10 azioni. Indicate un numero fra 1 e100.
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Mostra la griglia:

Posizionare nella
griglia

Colore della
griglia

Tipo di griglia

Distanza griglia
[Pixel]

Punti di appiglio

Usa punti di
appiglio

Grandezza dei
punti di appiglio
delle immagini

Grandezza dei
punti di
connessione
nell'editor dei
modelli

Angoli

Inverti colori di
sfondo:

Dimensione angoli

Attivo: Mostra nella finestra principale la griglia definita alla voce
Tipo di griglia.
Inattivo: La griglia non é visualizzata.

Attivo: glielementi ad immagine vengono sempre orientati
secondo la griglia. Questa funzione € indipendente dall’opzione
Mostra griglia.

Definisce i colori della griglia. Per la selezione dei colori viene utlizzata
la tavolozza di Wiindows.

Stabilisce il tipo della visualizzazione della griglia: continua,
punteggiata oppure intersezioni.

Definisce la distanza orizzontale e verticale fra i singoli punti. In tal
modo, si definisce anche quanto finemente devono essere
rappresentate le dimensioni dell’elemento. Distanza griglia consigliata:
10 pixel orizzontalmente e verticalmente.

Gli elementi dispongono di punti di appiglio. Se, spostando un oggetto,
ci si avvicina al punto di appiglio di un altro, il punto di appiglio
dell’oggetto selezionato ci si aggancia e si orienta rispetto ad esso.

Definisce la grandezza dello spazio di aggancio in pixel (angoli
quadrati). Indicate un numero fra 1 e 20.

Definisce la grandezza dello spazio di appiglio in pixel (angoli quadrati)
per |'orientamento di modelli ad altri modelli, oppure ai margini dello
schermo. Indicate un numero fra 1 e 40.

Attivo: ll colore degli angoli viene impostato in contrasto con lo
sfondo attuale.

Defnisce la grandezza in pixel degli angoli quadrati che servono per
agganciare un elmemento. Indicate un numero fra 1 e 20.
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Barra menu

Zzenon

7.7.2 Menu Tools

Nel dialogo Menu Tools potete implementare dei programmi esterni nella struttura di menu dell’editor.
| programmi integrati individualmente vengono mostrati alla fine del punto di menu opzioni .

ﬁ

| ioni | Menu tools | Farbschema | Comand | Toolbar |

Contenuti menu
[ Muovo... ] | Elimina | | 50 | | In giQ |
Proprietd
Menu testo
|Auﬂ10rit5 |
File
| C:\Program Files\Author-it 5\Authorits.exe | B
Parametri
[ ok ][ Abbrechen |
Contenuti Mostra una lista dei programmi esterni gia integrati.
menu:
Nuovo Aggiunge un nuovo inserimento di menu.
Elimina Elimina una voce di menu esistente.
Su: sposta verso I'alto I'inserimento di menu selezionato nella lista e nel menu.
Giu: sposta verso il basso I'inserimento di menu selezionato nella lista e nel menu.
Testo menu: nome con il quale viene visualizzato il nuovo menu nelle opzioni.
File Nome e percorso del programma esterno che deve essere aperto (file *.exe).
Parametri Ulteriore fattore per I'apertura del programma, per esempio un nome di file.
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= Esempio

Testo menu : Editor testo
File: C:\Windows\notepad.exe

Parametri: C:\test. txt

Apre Notepad e il file test.exe. Se questo file non esiste, il sistema propone di generarlo.

7.7.3 Schema colore

In questo tab definite lo schema colore per |'editor.

Impostazioni @
Farbschema | Comandi | Toolbar

Farbschema fir Editor

[Default v] [ Anteprima ]

oK ] [ Abbrechen




Barra menu

Zzenon

Schema colore per 1l editor

Cliccando sulla lista a cascata, aprite la lista con le
possibilita fra cui effettuare la scelta.

Anteprima Modifica lo schema colore dell’editor. La finestra di
dialogo rimane aperta.

OK Riprende e accetta le modifiche e chiude il dialogo.

Annulla.

Rifiuta le modifiche e chiude il dialogo.

7.7.4 Comandi

Nel dialogo comandi definite quali comandi devono essere a disposizione nella barra dei simboli.

T s

| i IMa-uindsl. bsct |Comandi|ronha,|

Kategorien: Befehle:

[tmmagini | Salva ~
Crientamento

Trasporto remoto Salva tutti

File Runtime Tadii L
Profili editor dy  1agia =
Macro VBA 3 Copia

Finestre ancorabil

Generatore Report b Incolla

Production & Fadility Scheduler o :

Liveli di visibiits ¢ | R

Elementi -+ Refresh pagina attiva

Alle Befehle .

)| Annulla -

Beschreibung:

[ ok ][ Abbrechen
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Opzioni Azione

Categorie Scelta della categoria che contiene il comando desiderato.
Comandi Lista dei comandi a disposizione.
Descrizione Testo per tooltip Se si porta il puntatore del mouse su un pulsante, una

breve descrizione della funzione di quest’ultimo viene visualizzata sotto
forma di tooltip.

AGGIUNGI SIMBOLO

=

aprite il menu Opzioni -> Impostazioni -> Tab: Comandi (auf Seite 75)
2. Selezionate nella finestra a sinistra una categoria.
3. Cliccate nella finestra di destra con il tasto sinistro del mouse sul simbolo desiderato.

4. tenendo premuto il tasto sinistro del mouse, trascinate il simbolo nella posizione desiderata

nella barra dei simboli

CANCELLA SIMBOLI

=

aprite il menu Opzioni -> Impostazioni -> Tab: Barra simboli (auf Seite 77)
2. vengono attivati tutti i simboli di tutte le barre nell’editor
3. Cliccate con il tasto sinistro del mouse sul simbolo.

4. Trascinate il simbolo fuori dalla barra simboli e rilasciate il tasto del mouse.

¥ Informazioni

Per annullare delle modifiche apportate ad una barra simboli e per instaurare lo stato di
fornitura, passate alla tab Barra simboli. Selezionate la barra dei simboliin
questione e cliccate sul pulsante Ripristina, oppure su Ripristina tutto per far si

che tutte le barre dei simboli siano riportate allo stato di fornitura.
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7.7.5

Barre dei simboli

Nel dialogo Barre simboli potete definire |'aspetto e la visibilita delle barre simboli.

Impostazioni

| Impostazioni I Menu tools I Farbschema I Comandi | Toolbar |

==l

Symbolleisten:

[¥]File Runtime

[]Immagini
[[IMacro vBA
[¥]Meniileiste
[T orientamenta

[#]Profili editor

["Finestre ancorabili
[¥]Generatore Report

[CLiveli di visibilita

[#]Production & Facility Scheduler

[#]Trasporto remoto

Alle zuriicksetzen

oK ] [ Abbrechen

Opzioni

Barre de
Annulla

Annulla

i simboli

tutto

8. Profili editor

Azione

Checkbox attivo: la barra simboli viene visualizzata nell’editor.
Ripristina lo stato di partenza per la barra simboli evidenziata

Ripristina lo stato di partenza per tutte le barre simboli

L editor si apre in un’impostazione standard con finestre predefinite. Potete ordinare e attivare le
finestre a piacere. | dettagli relativi li potete trovare nel capitolo Adatta visualizzazione (auf Seite 12)
Gestite le Vostre impostazioni individuali nei profili. Li raggiungete tramite

» la barra dei simboli Profili editor

(vedi: Gestisci profili editor nella barra dei simboli (auf Seite 82))
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» il sottopuntoGestisci profili editor nelle opzioni della barra menu.
(vedi Gestisci profili editor mediante il menu (auf Seite 83))
» Mediante delle combinazioni di tasti

(vedi Gestisci profili editor con combinazioni di tasti (auf Seite 84))

Potete attribuire dei profili editor a dei singoli moduli anche tramite menu contestuale (vedi Seleziona
profili editor nel menu contestuale (auf Seite 85)) o potete usare dei profili predefiniti (auf Seite 78).

¥ Informazioni

Nel caso di finestre divise (come nel managerdi progetto, nella visuale generale e in
quella dettagliata), la definizione della larghezza vale per la finestra nel suo complesso.
Al momento dell’avvio e della chiusura dell Editor, il sistema stabilisce la corretta

relazione delle dimensioni della finestra stessa.

Se la relazione reciproca degli elementi della finestra viene modificata, un’apertura di un
profilo provoca solamente |'impostazione della finestra nel suo complesso in base ai
valori definiti. La relazione reciproca fra visuale generale e dettagliata, per esempio, non

viene modificata.

8.1 Profili predefiniti

In zenon sono a Vostra disposizione tre profili predefiniti. Ottimizzate il layout dell’editors con una
risoluzione di 1280 x 1024 per:

» Variabili e visualizzazione lista: profilo 1 spazio di memoria P1
» Immagini: profilo 2 spazio di memoria P2

» Standard per compiti generali: profilo 3 spazio di memoria P3.

SELEZIONARE PROFILO PREDEFINITO

Potete attivare o disattivare questi profili. A tal scopo usate o i Simboli (auf Seite 82) nella barra dei
simboli per i profili editor, oppure:

1. aprite il menu opzioni.
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2. cliccate su Gestisci profili editor
e Carica Profili predefiniti: carica i profili predefiniti sui primi tre posti di memoria
e li collega ai moduli. Profili eventualmente gia esistenti vengono sovrascritti.
e Elimina attribuzioni di profili: Cancella tutti i collegamenti di profili predefiniti
con i moduli.

Per utilizzare i profili, selezionate in corrispondenza del modulo desiderato nel menu contestuale Profilo
editor -> [Numero profilo]

SEGNALAZIONE DI ERRORE AL MOMENTO DELL"APERTURA DI PROFILI
PREDEFINITI

Se al momento della selezione di un profilo predefinito ricevete una segnalazione di errore con il
rimando a zenAdminSrv, Ci0 pud avere due cause:

1. Il servizio zenAdminsrv funziona con un numero di versione inferiore a quello dell’editor attuale.

Soluzione: sincronizzate il servizio.

2. | profili sono stati eliminati dal percorso standard:
Soluzione: copiate il file Predefined Editor Profiles.epf nella cartella
C:\ProgramData\COPA-DATA\zenonxxx\EdProfiles (xxx corrisponde alla versione

attuale di zenon).
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Profili editor

Zzenon

PROFILI

PROFILO 1: VARIABILI

Rappresentazione ottimizzata per la modifica di variabili e visualizzazioni lista.
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Profili editor

Zzenon

PROFILO 2: IMMAGINI

Rappresentazione ottimizzata per la modifica di immagini.
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Profili editor

Zzenon

PROFILO 3: STANDARD

Visuale standard, ottimizzata per moduli che non si basano su liste.
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8.2 Gestisci profili editor con la barra dei simboli

La barra dei simboli per i profili editor viene visualizzata nell’editor al centro della seconda riga di
simboli (default). Nel caso in cui sia stata disattivata, cliccate con il tasto destro del mouse accanto alla
varra dei simboli e scegliete Profili editor. Riceverete la seguente barra simboli:

Editorprofile
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Simbolo
(da sinistra a destra)

Carica profilo editor
selezionato

Seleziona profilo
editor

Carica profilo
standard

Carica Profili
predefiniti: (auf Seite
78)

Elimina attribuzioni
di profili: (auf Seite 78)

Salvataggio automatico
dei profili editor

Salva profilo editor
selezionato

Assegna nomi
individuali ai profili
editor.

Opzioni per barre
dei simboli

Funzione

Carica il profilo selezionato nel settore Seleziona profilo editor.

Lista a cascata (auf Seite 86) con 10 profili.

Resetta tutte le impostazioni relative a visualizzazione e posizione delle
finestre, nonché contenuti e visualizzazione delle barre dei simboli e dello
stato di emissione; poi carica il profilo standard di zenon.

carica i profili predefiniti di COPA-DATA sui primi tre posti di memoria e li
collega ai moduli. Profili eventualmente gia esistenti vengono sovrascritti.

Cancella tutti i collegamenti di profili predefiniti con i moduli.

Attivo:
automaticamente al momento dell’apertura di un altro profilo.

le modifiche del profilo attuale vengono salvate

Disattivato: le modifiche non vengono salvate al momento del
cambiamento di profilo; quando si richiama un’altra volta il profilo in
questione, vengono riproposte le posizioni originali.

Salva le impostazioni finestra attuali nel profilo che & visualizzato nel settore

Seleziona profilo editor.

Apre un Dialogo (auf Seite 86) in cui possono essere assegnati dei nomi
individuali ai profili editor.

Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso del
menu Opzioni -> Barre dei simboli.

Per esportare o importare dei profili editor, selezionate |’'opzione corrispondente nel Menu principale
(auf Seite 83) alla voce Opzioni -> Editor Gestisci profili editor.

8.3 Gestisci profili editor mediante il menu

Per gestire i Vostri profili editor, selezionate nel menu Opzioni -> Editor Gestisci profili editor.
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Profili editor

Zzenon

Avete le seguenti possibilita:

Nomina Apre un Dialogo (auf Seite 86) in cui possono essere assegnati dei nomi
individuali ai profili.

Carica profilo | Riporta tutte le impostazioni finestra allo standard di default e carica il
standard profilo standard di zenon.

Esportare Apre il Manager file e salva le impostazioni sotto forma di file .zip in un posto
che puo essere scelto liberamente.

Importare Apre il Manager file al fine di importare delle impostazioni salvate sotto
forma di un file .zip da un luogo qualsiasi nel quale le si era salvate.

Per selezionare dei profili editor individuali o per salvarli, usate le funzioni corrispondenti della Barra
simboli (auf Seite 82) o Combinazioni di tasti (auf Seite 84).

8.4 Gestisci profili editor con combinazioni di tasti

Sono disponibili le seguenti azioni:

Carica profilo editor 1 Shift+F1
Carica profilo editor 2 Shift+F2
Carica profilo editor 3 Shift+F3
Carica profilo editor 4 Shift+F4
Carica profilo editor 5 Shift+F5
Carica profilo editor 6 Shift+F6
Carica profilo editor 7 Shift+F7
Carica profilo editor 8 Shift+F8
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Salva visuale editor attuale come:

Profilo editor 1 Ctrl+Shift+F1
Profilo editor 2 Ctrl+Shift+F2
Profilo editor 3 Ctrl+Shift+F3
Profilo editor 4 Ctrl+Shift+F4
Profilo editor 5 Ctrl+Shift+F5
Profilo editor 6 Ctrl+Shift+F6
Profilo editor 7 Ctrl+Shift+F7
Profilo editor 8 Ctrl+Shift+F8

8.5 Seleziona profili editor nel menu contestuale

Nel Manager di progetto, per ogni progetto e ogni suo sottolivello possono essere selezionati e asegnati
in modo duraturo dei profili editor facendo uso del menu contestuale: cliccare con il tasto destro del mouse
sul ramo > Seleziona -> Profili editor.

E’possibile eliminare una assegnazione scegliendo il punto 'nessuno' nel menu contestuale.

Questa preselezione é possibile per tutti i rami e moduli, fatta eccezione per il Energy Management
SystemelaLibreria dei simboli globale.

8.6 Elimina profili editor

| profili editor vengono salvati in un file INI proprio. Per cancellare i Vostri dati profili, Vi consigliamo di
cancellare tutta la cartella che contiene le impostazioni profili.

Cancellate la cartella Editor. La trovate, a seconda del sistema operativo, sotto:

Windows Vista, Windows 7: C: \Users\USERNAME\AppData\Local\COPA~-
DATA\zenon\Editor

Windows XP C:\Dokumente und Einstellungen\USERNAME\Lokale
Einstellungen\Anwendungsdaten\COPA-DATA\zenon\Editor
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Indicazione: dovete sostituire lo USERNAME con il nome utente dello user Windows registrato.

8.7 Dialogo per nome dei profili editor

Potete assegnare individualmente dei nomi ai profili editor: direttamente nella Barra simboli (auf Seite
82), tramite Combinazione di tasti (auf Seite 84) oppure facendo uso di un dialogo. Potete passare al
dialogo in questione attraverso:

» barra simboli, simbolo Assegna nome individuale per profili editor oppure

»  Menii -> Opzioni -> Editor Gestisci profili editor -> Nomina

[Nome del profilo

Mome del profila

P1-

F2-

P3-

P4-

25

Pé-

F7-

Pe-

Pa-
P10-

[ OK ] I Annulla ]I Guida I

Inserite nei campi dei nomi individuali digitandoli dopo la denominazione breve-profilo editor. Facendo
uso della combinazione di tasti Shift+F1 finoa Shift+F8 potete aprire in qualsiasi momento i primi 8
profili nell’editor. Oppure potete selezionare il profilo editor desiderato facendo uso del simbolo
corrispondente nella Barra dei simboli (auf Seite 82).

9. Manager di progetto

Il Manager di progetto si trova di default sul margine sinistro dello schermo, direttamente sotto la barra
dei simboli. La visualizzazione pud avvenire in due modi:

» Struttura ad albero del progetto

» Topologia di rete
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STRUTTURA AD ALBERO DEL PROGETTO

La struttura ad albero del progetto contiene:

» asinistra, il workspace con i progetti e la Libreria dei simboli globale.:

e Nel workspace si trovano tutti i progetti caricati con le loro variabili, funzioni,
immagini ecc.

e Lalibreria simboli globale contiene delle grafiche predefinite e offre la possibilita di
creare delle nuove grafiche.

» adestra una visione dettagliata:

presenta una lista di tutti gli elementi e delle impostazioni per il settore della visione ad
albero che é stata selezionata.

TOPOLOGIA DI RETE

La visuale Topologia di rete rappresenta topologicamente tutti i progetti nel workspace e permette di
controllare tutte le componenti di rete coinvolte, nonché di effettuare un trasporto remoto dei file
runtime ai computer connessi.

Potete leggere i dettagli su questo argomento nella sezione Rete e in particolare nel capitolo Controlla la
validita della Topologia di rete.

9.1 Area di lavoro (Workspace)

Nellarea di lavoro si amministrano le seguenti componenti di un progetto:

» Variabili
e Driver
e Tipi di dato

o Matrice di reazione
e Attribuzioni
e Allarm

¢ Unita di misura

» Immagini
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e Modelli

e Tipi di carattere

e Tavolozza dei colori
e Simboli di progetto
Funzioni

e  Script:
File lingua
Server archivi

Ricette
e Ricette standard

e Manager gruppi ricette
Temporizzatori

Interfacce di programmazione
e Process Control Engine

¢ Macro VBA
e VSTA

zenon Logic € un ambiente di sviluppo per [EC 61131-3.

Production and Facility Scheduler
Interblocchi

Comando

Energy Management System
Message Control

Menu

Generatore di rapporti

Gestione utenti

Interfaccia SAP

File: aggiunge file esterni. Essi non vengono modificati con zenon, ma con un programma

esterno.
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e  Grafici
e Tabella lingua
e Guida

e Multimedia

e Liste
e Driver
o Altri

» Log modifiche progetto

» Backup di progetto

La disponibilita delle singole componenti puo dipendere dalla licenza scelta. Potete verificare per quali
moduli possedete la licenza cliccando su Help > Info su.....

Per eventuali estensioni della Vostra licenza Vi preghiamo di rivolgervi al Vostro distributore, oppure a
sales@copadata.com.

¥ Informazioni

I singoli elementi del manager di progetto, come variabili e funzioni, possono essere
visualizzati in una finestra propria. A questo scopo, cliccate nel menu contestuale su Apri
in nuova finestra. In tal modo potete, ad esempio, modificare contemporaneamente

variabili e funzioni.

9.2 Sezione lista del manager di progetto

Se si sceglie un elemento nella visione ad albero del Manager di progetto, la visualizzazione dettagli
mostra tutti gli oggetti relativi e le loro proprieta.

Nel caso di una visualizzazione a tabella, potete:
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Azione Modo di procedere:

Seleziona liberamente le clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale ->
colonne: Seleziona colonna

Modifica la larghezza di > muovere il puntatore del mouse sulla linea di separazione nel titolo della colonna
una colonna: finché esso non assume la forma di una croce.

> tenere premuto il tasto del mouse.
»  Trascinare la colonna finché non avra la dimensione desiderata.

Ordina colonne: un clic del mouse sul titolo colonna ordina la lista nel modo opposto all’ordine
attuale (crescente/ decrescente).

Formatta colonna clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale ->
Formatta colonna

Raggruppa proprieta clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale ->
Raggruppa sulla base di questa colonna oppure

clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale ->
Annulla raggruppamento

Adatta visualizzazione alla | clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale ->
larghezza della finestra Adatta la grandezza alla larghezza della colonna

Elimina colonna clic con il tasto destro del mouse sul titolo di una colonna-> Menu contestuale ->
Elimina questa colonna

MENU CONTESTUALE

Comando Azione

crescente ordina colonna in senso crescente

decrescente ordina colonna in senso decrescente

Raggruppa per questa colonna raggruppa elementi in relazione a questa colonna
Elimina raggruppamento elimina il raggruppamento esistente

Selezione colonne .... apre il dialogo che serve alla selezione delle colonne

che devono essere visualizzate
Formatta colonna apre il dialogo che serve a formattare la colonna
Adatta alla larghezza della finestra distribuisce tutte le colonne sull’intera finestra

Elimina questa colonna elimina la colonna dalla visualizzazione



RIGA DI STATO

Nel caso delle liste, la barra di stato della visualizzazione dettagliata mostra le informazioni sugli
elementi esistenti, filtrati e selezionati.

# Esempio

Visualizzazione della barra di stato. Visualizzazione dettagliata: 39 nel complesso / 30

filtrati / 2 selezionati significa

» sono disponibili complessivamente 39 elementi

» 30 vengono visualizzati sulla base delle impostazioni di filtro che sono state
adottate.

» 2 sono stati selezionati

Nel caso delle variabili, viene anche visualizzato il numero dei tags o di 10s utilizzati e provvisti di
licenza.

per esempio: 32 tag utilizzati / Tags illimitati disponibili.

¥ Informazioni

Delle informazioni dettagliate concernenti la modifica e la gestione degli elementi, le
trovate nel capitolo Modifica inserimenti (auf Seite 91) e nella descrizione

dell’elemento in questione.

9.2.1 Modifica inserimenti

Per modificare degli inserimenti, sono a Vostra disposizione diverse possibilita:
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percorso Procedura

Barra dei simboli della »
sezione lista

»
Menu contestuale 4

»
Doppio clic ritardato 4
Finestra di proprieta »

»
Tasto F2 »

¥ Informazioni

Selezionate servendovi del tasto sinistro del mouse la cella desiderata.
Selezionate nella barra simboli il pulsante Modifica Celle selezionate.
Cliccate con il tasto destro del mouse nella cella desiderata.

Selezionate nel menu contestuale I'inserimento Modifica cella

selezionata.

Evidenziate la cella desiderata cliccando due volte a breve distanza di tempo

(cliccare due volte lentamente).

Selezionate I’'elemento desiderato.

Impostate nella finestra Proprieta l'inserimento desiderato.
Selezionate servendovi del tasto sinistro del mouse la cella desiderata.

Premete il tasto F2.

Cliccando in una cella, essa viene selezionata nella sua interezza. Riconoscete quali celle

avete selezionato grazie al simbolo del binocolo che vedete nel titolo della colonna.

A Attenzione

Eccezioni

» Nella visualizzazione dettagliata possono essere modificate solo quelle

proprieta che sono modificabili anche nella finestra delle proprieta. Cosi, per

esempio, non si pud modificare il nome di una variabile di driver di sistema.

» La storia delle modifiche non € modificabile a causa di quanto previsto dalle

norme FDA.

» Per quello che concerne i backup di progetto, & modificabile solo il nome del

backup.
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9.2.2 Barra dei simboli della sezione lista

Al margine superiore della sezione lista, potete usare in una barra simboli tutte le funzioni che potete
trovare anche nel menu contestuale. A seconda di cosa avete selezionato nella vista ad albero del
progetto (ad esempio: immagini, variabili, simboli ecc.), vengono visualizzati differenti pulsanti nella
barra dei simboli.

Quei pulsanti che non e consentito utilizzare, sono disattivati e non reagiscono se ci si clicca sopra.

BARRA SIMBOLI

|M@| | Bz M % | BE ~ | - B EE)
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No.

01

02

03

04

05

06

07

08

09

10

11

12

13

14

15

16

17

18

Simbolo

Nuova Variabile
Copiare

Incolla

Elimina

Crea una funzione
standard

Modifica celle
selezionate

Sostituisci testo nella
colonna selezionata...

Sostituisci testo in
valore limite

Proprieta

Espandi tutto

Attiva
Disattiva
Attiva tutti

Esporta selezione in
XML

Importa XML...

Importazione progetto
S7

Attiva

Torna all'elemento
originario

Azione

Apre il dialogo per la creazione di una nuova variabile.
Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento é gia esistente
con lo stesso nome, il contenuto viene aggiunto come "copia di".

Cancella gli inserimenti selzionati.

Apre |'assistente per la selezione delle variabili e dei valori impostabili
e che crea una funzione adatta. L'azione viene documentata nella
finestra di emissione.

Apre la cella selezionata per effettuarne la modifica Vedete quale
cella & stata selezionata in una riga evidenziata facendo riferimento al
simbolo della lente di ingrandimento nella riga titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.

Apre il dialogo che serve a selezionare la proprieta dinamica e, di
seguito, il dialogo che serve alla ricerca e alla sostituzione.

Apre la finestra Impostazioni per |'inserimento selezionato.

Lista a cascata per estedere tutti nodi o quelli selezionati, oppure per
ridurli.

Attiva gli elementi selezionati di una variabile struttura.
Disattiva gli elementi selezionati di una variabile struttura.
Attiva tutti gli elementi non attivi di una variabile struttura.

Esporta tutti gli inserimenti in un file XML.

Importa file XML.

Importa un progetto Simatic S7.

attiva o disattiva impostazioni di filtro estese.

Quando si & passati tramite la funzione Elementi collegati nella
lista, il simbolo riporta all’elemento di partenza.

Nel menu contestuale esistente solamente, se aperto come elemento
collegato.
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19 Elimina filtro

20 Guida

MENU CONTESTUALE

Punto di menu

Nuova Variabile
Copiare

Incolla

Elimina

Crea una funzione
standard

Modifica celle
selezionate

Sostituisci testo nella
colonna selezionata...

Sostituisci testo in
valore limite

Proprieta

Ingrandisci / riduci nodo
Attiva tutti

Attiva

Disattiva

Esporta selezione in XML
Importa XML..

Importazione -
Esportazione estesi

Variabili utilizzate

Filtri estesi

Elimina tutte le impostazioni di filtro

Attiva la guida online

Azione

Apre il dialogo per la creazione di una nuova variabile.
Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento é gia esistente
con lo stesso nome, il contenuto viene aggiunto come "copia di".

Cancella gli inserimenti selzionati.

Apre il dialogo che serve alla selezione delle variabili e dei valori
impostabili.

Apre la cella selezionata per effettuarne la modifica Vedete quale cella
e stata selezionata in una riga evidenziata facendo riferimento al
simbolo della lente di ingrandimento nella riga titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.
Apre il dialogo che serve a selezionare la proprieta dinamica e, di
seguito, il dialogo che serve alla ricerca e alla sostituzione.

Apre la finestra Impostazioni per |'inserimento selezionato.
Apre un sottomenu che serve ad estendere e chiudere i nodi.
Attiva tutti gli elementi non attivi di una variabile struttura.
Attiva gli elementi selezionati di una variabile struttura.

Disattiva gli elementi selezionati di una variabile struttura.

Esporta tutti gli inserimenti in un file XML.
Importa da file XML.

Apre il menu per importare ed esportare i progetti/S7, dBase und csv.

Realizza una analisi di progetto delle variabili selezionate nel progetto
attuale e la mostra in forma di Lista risultati in una finestra apposita.

Apre il sottomenu che serve ad attivare o a disattivare dei filtri, oppure
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ad eliminare tutte le impostazioni di filtro.
Elementi collegati Mostra gli elementi collegati con le variabili.

Guida Attiva la guida online

9.2.3 Navigazione nella sezione lista

Per navigare in una lista:

1. cliccate sulla colonna nella quale deve essere effettuata la ricerca.

2. Toccate il primo segno per avviare la ricerca. Nel caso non esista nessun inserimento che inizia

con questa lettera, la ricerca si interrompe immediatamente.

3. L’inserimento trovato viene seletzionato. Appare un campo di inserimento. Il primo segno del
testo di cella é evidenziato.
Indicazione: Potete indicare in questo campo dei criteri di ricerca, ma non potete moficare il

nome dell’elemento.

4. Indicate ulteriori caratteri per limitare la ricerca. Nel caso in cui non si trovi nessun inserimento

adatto, il carattere digitato viene rifiutato e la selezione rimane alla posizione attuale.

5. Nel caso in cui siano disponibili pil inserimenti corrispondenti al criterio di ricerca, potete

navigare con i tasti Ctr1+Su oppure Ctrl+ Giu.

6. Coniltasto BACKSPACE viene cancellato I'ultimo carattere del criterio di ricerca e viene avviata
una nuova ricerca sulla base dei segni residui. Con la cancellazione dell’ultimo segno, la ricerca

viene conclusa.
ORDINAMENTO
Per ordinare nella visuale a lista, potete selezionare anche piu colonne contemporaneamente.

1. cliccate nell’intestazione della colonna con il primo criterio di ordinamento

2. tenete premuto il tasto shift e cliccate sul titolo della colonna con il secondo criterio di

ordinamento;
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3. Intal modo, potete aggiungere un numero qualsiasi di colonne

Ad esempio: ordinamento sulla base di blocco dati e offset mostra in primo luogo tutti i
blocchi dati e tutti gli indirizzi relativi ordinati in modo corretto.

Un consiglio: cliccando una seconda volta sul titolo della colonna si cambia la successione
dell’ordinamento

9.2.4 Filtra inserimenti lista

Elementi della visualizzazione dettagliata possono essere filtrati e ordinati secondo diversi criteri.
Mediante il pulsante Elimina tutti i £iltri nella lista simboli della visualizzazione dettagliata
oppure il comando Elimina tutti i f£iltri nel menu contestuale, vengono azzerate tutte le
impostazioni di fultro.
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Metodo

Classificazione in
ordine alfabetico

Assegnazione dei
criteri di filtro

Filtra secondo i
checkbox

Caratteri simbolici

Collegamento
logico

Contenuti della
cella come
criterio di filtro

Procedura

Clic del mouse sul titolo di una colonna: La lista viene ordinata secondo la colonna
corrispondente. Un secondo clic con il mouse sul titolo della colonna, inverte I'ordine
di ordinamento.

Direttamente sotto il titolo della colonna si trova un campo per |I'impostazione dei
criteri di filtro. In questa sede vengono indicati dei criteri.

Poi verrano visualizzati solamente quegli oggetti che corrispondono al criterio di filtro
indicato.

Per far si che vengano visualizzati di nuovo tutti gli oggetti, bisogna eliminare il criterio
di filtro.

Cliccando nel settore filtro si apre una lista dropdown che contiene i filtri usati per
ultimi di questa colonna.

Liste con checkbox (per es. templates) possono essere ordinati e filtrati in checkbox
attive e non attive.

Cio funziona allo stesso modo della classificazione in ordine alfabetico.

Per effettuare il filtraggio trovate in una cella sotto il titolo della colonna una lista
dropdown con la selezione di checkbox attive, inattive o tutte.

Per i criteri di filtro sono a disposizione caratteri simbolici:

> * sostituisce una successione di segni.
Esempio: *1 filtra cercando gli elementi che finiscono con il segno 1 per esempio
Variabile 1.

Le wildcard possono essere usate solamente come prefisso o suffisso.

> ? sostituisce un unico segni.
Esempio: Variabile? filtra tutti gli elementi che iniziano con la successione di caratteri
Variabile e che hanno un ulteriore segno, per esempio Variabilel, Variabile

2,Variabile 3..

Le parole filtro possono essere collegate mediante espressioni logiche, quali, ad
esempio, AND e OR. Cio funziona anche nel caso si utilizzino delle wildcard (*), ma non
nel caso di caratteri jolly per singoli segni (?).

Le parole o le successioni di segni di un cella della visualizzazione dettagliata possono
essere utilizzati come criterio di filtro:

» Selezionate l'inserimento desiderato.
>  Tenete premuto il tasto ALT e cliccate sulla cella.

» L’inserimento viene reso disponibile in un campo di editazione.
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Effetto del filtro
Elementi
collegati

Modifica
proprieta

Filtri estesi per le
variabili

> Selezionate una qualsiasi successione di segni facendo uso del mouse.

> Trascinate la parte selezionata tenendo premuto il tasto sinistro del mouse (Drag&Drop)

sulla cella di filtro del capo della colonna.

»  Lasuccessione di caratteri scelta viene presa come nuovo testo di filtro.

Facendo uso dell’'opzione Elementi collegati € possibile visualizzare quegli
elementi che sono collegati con I'elemento attuale. Se con questa opzione si passa ad
un elemento della visualizzazione dettagliate, per esempio ad una variabile, esso viene
mostrato indipendentemente dalle impostazioni di filtro attuali. Se non € contenuto
nel filtro attuale, viene comunque indicato alla fine della lista e viene selezionato
automaticamente.

Dopo aver creato o selezionato un oggetto nella sezione lista o tramite il menu
contestuale, i suoi parametri possono essere definiti o modificati nella finestra
proprieta.

Sono consentite inoltre selezioni multiple. Nel caso dovessero essere stati selezionati
contemporaneamente pill oggetti, possono essere modificate nello stesso tempo le
loro proprieta.

Inserimenti e modifiche nella finestra delle proprieta valgono per tutti gli oggetti
evidenziati. Gli inserimenti validi fino ad allora vengono sovrascritti. Nella finestra
proprieta, pero, sono a disposizione solo quelle proprieta che valgono per tutti gli
inserimenti selezionati.

Per le variabili & disponibile un dialogo per raffinare i filtri. Passate a questo filtro nel
seguente modo:

> conilsimboloAttiva filtri estesi nella barra deisimbolinella visualizzazione

dettagliata oppure

» conilcomando filtri estesi nel menu contestuale

| filtri standard vengono estesi con gli elementi Tipi di dato, Flag di selezione
e Filtro stringa (nome variabili, identificazione, matrice di reazione).

9.2.5 Sostituisci testo nella colonna selezionata...

zenon supporta la funzionalita cerca/sostituisci per le string (per esempio, nome immagine, nome
variabile, identificazione variabile): Potete sostituire dei testi in colonne attive e in valori limite.
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& Attenzione

Si tiene conto solamente dei testi che si trovano in strutture aperte (variabili o tipi di

dato). Le strutture chiuse non sono destinazioni per I’editor come destinazioni e, prima di

iniziare la ricerca, bisogna estenderla.

SOSTITUISCI TESTO NELLA COLONNA SELEZIONATA:

1. Attivate il dialogo facendo uso del simbolo Sostituisci testo nella colonna selezionata,

oppure usando il comando del menu contestuale che ha lo stesso nome.
2. Definite nel dialogo i parameteri per la ricerca e la sostituzione.

3. Le sostituzioni vengono effettuate nella colonna attiva. Riconoscete qual € la colonna attiva

vedendo il simbolo Binocolo accanto al titolo della colonna.

Sostituisci testo nella colonna selezionata..

Trova: Tank1_m

Sostituisci con:  Tank2_m

Solo parole intere

Maiuscole/minuscole

Nome:
Tank1_max

Anteprima:
Tank?2_max

==l

Sostituisci
Sostituisci tutto
Annulla
—

AN Attenzione

Viene usato nella identificazione variabili Cambio immagine (riconoscibile a causa della
parola chiave @), al fine di una ricerca e sostituzione corretta deve essere attiva la

prorieta di progetto Visualizzare parole chiave non tradotte. Per

attivarla:

»  passate alla proprieta di progetto, in particolare al nodo Aspetto grafico

) attivate la checkbox della proprieta Visualizzare parole chiave non

tradotte
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9.2.6 Sostituisci testo in valori limite

Per sostituire testi in valori limite:

» attivate il dialogo facendo uso del simbolo Sostituisci testi in valori limite, oppure usando il

comando del menu contestuale che ha lo stesso nome.

» Selezionate nella finestra di selezione la proprieta dinamica desiderata.

Seleziona 'dynamic property’ @
Dynamic propertis disponibili
Capitolo guida[1]

Capitolo guida[2]

File guida[1]

File guida[Z]

Proprietd utente 1[1]
Proprietd utente 1[2]
Propriet utente 2:[1]
Proprietd utente 2:[2]
Testo valore limite[1]

Testo valore limite[2]

[ OK ] I Annulla ]I Guida I

» Passate cosi al dialogo per Sostituisci testo in valori limite.

Sostituisci testo nei valori limiti...

Trova:

Sostituisci con:

[ Solo parole intere

) ) Annulla
[ Maiuscole/minuscole

La proprieta non esiste

Capitolo guida[1]:

Anteprima:

& Attenzione

Si tiene conto solamente dei testi che si trovano in strutture aperte (variabili o tipi di
dato). Le strutture chiuse non sono destinazioni per |’editor come destinazioni e, prima di

iniziare la ricerca, bisogna estenderla.
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9.2.7 Mostra e nascondi colonne

Le colonne disponibili nella visualizzazione dettagliata possono essere mostrate e nascoste a piacere e

possono essere ordinare in qualsiasi successione vogliate. Per alcune immagini, le seguenti impostazioni

possono essere realizzate anche facendo uso di dialoghi di cambio immagine.

MOSTRA E NASCONDI COLONNE

1. Cliccate con il tasto destro del mouse su un titolo di una colonna

2. e selezionate nel menu contestuale selezione colonne

3. nel seguente dialogo selezionate Mostra Nascondi colonne:

potete selezionare piu colonne (esattamente come usuale nel sistema operativo) tenendo
premuto shift oppure Ctrl

4. colonne disponibili realizza una lista di tutte le colonne ancora disponibili. colonne

selezionate mostra tutte le colonne attive.

Proprieta colonne

Scelta colonne

Colonne disponibili:

Acknowledgement value

Active

Address
AdjustHardwareValue
AdjustScadavalue
Alarm area

Alarm variable 1
Alarm variable 2
Alarm variable 3
Alternate value
automatic addressing
Block array size
Calculation
Command group
Cydle time [s]

DDE active

Dim 1

Dim 2

Dim 3

Acknowledgement variable

m

Aggiungi tutti-=

Colonne selezionate:
Status Annulla
Name
Identification
Unit

Met address
Data block
Offset

Bit number
Alignment
Driver
Datatype
Decimals
Start offset
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Pulsanti

Aggiungi

Aggiungi tutte

Rimuovi

Cancella tutte

In su

In giu

OK
Annulla

Guida

ORDINA COLONNE

Funzione

Sposta le colonne selezionate da quelle disponibili a quelle selezionate. Dopo aver
confermato il dialogo cliccando su OK, esse vengono visualizzate nella visualizzazione
dettagliata.

Sposta tutte le colonne disponibili nelle colonne selezionate.

Elimina le colonne evidenziate dalle selezionate e le visualizza nella lista di quelle
disponibili. Dopo aver confermato il dialogo cliccando su OK, esse vengono eliminate
dalla visualizzazione dettagliata.

Cancella tutti le colonne dalla lista delle colonne scelte.

Sposta lI'inserimento selezionato verso |’alto. Questa funzione &€ sempre disponibile
per inserimenti singoli, non & possibile pero nel caso di una selezione multipla.

Sposta I'inserimento selezionato verso il basso. Questa funzione & sempre disponibile
per inserimenti singoli, non & possibile pero nel caso di una selezione multipla.

Riprende le impostazioni e chiude il dialogo.
Rifiuta le impostazioni e chiude il dialogo.

Apre la guida online

Le colonne possono essere ordinate a piacimento. Avete due possibilita di far cio:

1. nel dialogo Colonne-Proprieta facendo uso del pulsanteverso 1°alto € Verso il basso.

2. Nella visuale dettagliata del manager di progetto per bragsbrop usando il mouse:

e Cliccate con il mouse nel titolo colonna desiderato.

e Tenete premuto il tasto sinistro del mouse.

e Trascinate il titolo colonna nella posizione desiderata. Due frecce rosse segnano il
posto nel quale viene inserita la colonna.

e Posizionate la colonna rilasciando il tasto del mouse.
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Manager di progetto
zenon

9.2.8  Proprieta colonne

Popedcome T .. ==
Formatta colonne
Colonne disponibili W
froesmen [ anse |
s
100 Carattere
Orientamento
@ Orientamento a sinistra
(0} Centrato
7 Orientamento a destra
|| Disattiva fitro colonne a Runtime
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Parametri Descrizione

Colonne disponibili Lista delle colonne disponibili facendo uso della Selezione colonne. La
colonna selezionata in questa sede viene configurata mediante le proprieta
della sezione Parametri.

Parametri Impostazioni per colonna selezionata.

Descrizione Nome del titolo della colonna Il titolo colonna é traducibile online. A tal
scopo dovete inserire il carattere @ prima del nome.

Larghezza Larghezza della colonna in caratteri.
Calcolo: numero per larghezza media del carattere selezionato.

Orientamento Orientamento.
Impostazioni possibili:

»  Orientamento a sinistra: nella colonna, il testo si dispone prendendo a

riferimento il bordo sinistro.
»  Centrato: nella colonna, il testo si dispone in posizione centrale.

»  Orientato a destra: nella colonna, il testo si dispone prendendo a riferimento il

bordo destro.

Blocca il filtro attivo: Ilfiltro per questa colonna non puo essere modificato durante il
colonna Runtime.
nell “immagine di o . .
processo Indicazione: disponibile solo per:

»  Batch Control

»  Trend esteso

>  Message Control

> Manager gruppi ricette
OK Riprende le impostazioni e chiude il dialogo.
Annulla Rifiuta le impostazioni e chiude il dialogo.
Guida Apre la guida online
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9.3 File

Dei file esterni possono essere integrati in un progetto facendo uso del nodo File del Manager di
progetto. Per modificare dei file esterni, deve essere disponibile un programma adatto a questo scopo.
Cio significa: potete implementare, per esempio, un video. Per modificarlo, perd, dovete disporre del
software necessario. zenon amministra solo questi file.

Sono disponibili i seguenti file esterni:

» Grafici (auf Seite 107)

» Guida (auf Seite 109)

» Multimedia (auf Seite 111)

» Testi e formati (auf Seite 113)
» Driver (auf Seite 115)

» Report Viewer (auf Seite 118)

»  Altri (auf Seite 119)
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SOTTOCARTELLA

In corrispondenza del nodo Help, Liste, Multimedia e Altro € possibile impostare delle sottocartelle. A tal
scopo, usate il comando Nuova cartella che trovate nel menu contestuale. Con I'aiuto di sottocartelle, potete
usare anche su documenti cambi lingua durante il runtime.

MENU CONTESTUALE

Punto di menu Azione

Importa file grafico Apre il Manager file che serve alla selezione di un file.
Importa tabella lingua Apre il Manager file che serve alla selezione di un file.
Importa file help Apre il Manager file che serve alla selezione di un file.
Importa file multimediale Apre il Manager file che serve alla selezione di un file.
Importa file lista Apre il Manager file che serve alla selezione di un file.
Importa file driver Apre il Manager file che serve alla selezione di un file.
Importa modello report Apre il Manager file che serve alla selezione di un file.
Importa altri tipi di file Apre il Manager file che serve alla selezione di un file.
Help Attiva la guida online

9.3.1  Grafici

| file grafici per le grafiche di sfondo o gli elementi dinamici. Sono disponibili i seguenti formati:

» *bmp
» *gif
> *.jpg
» *.png
>  *wmf

» *XAML Avvertenza: disponibile solo per elemento WPF! | file XAML dispongono di

un’anteprima nella visualizzazione dettagliata!
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Manager di progetto
Zenon

MENU CONTESTUALE

Inserisci file Apre il Manager file che serve alla selezione di un file.

Nuova cartella Aggiunge una nuova sottocartella.

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in
proprio.

Cancella cartelle Cancella la cartella selezionata, che € stata creata in proprio, dopo la

richiesta di conferma.

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 77) predefiniti.

Guida Attiva la guida online

Grafiche Barra simboli e menu contestuale

SRR RBRX SlLsF@
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MENU CONTESTUALE GRAFICHE

Punto di menu

Inserisci file

Modifica file esterni

Modifica file esterni con
Copiare

Incolla

Elimina

Modifica celle
selezionate

Sostituisci testo nella
colonna selezionata...

Proprieta
Elimina tutti i filtri

Guida

9.3.2 Guida

Azione

Apre il Manager file che serve alla selezione di un file.

Apre il sistema operativo come programma definito di default per la
modifica del file selezionato.

Apre una lista di programma adatti alla modifica del file selezionato

Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento é gia esistente
con lo stesso nome, il contenuto viene aggiunto come "copia di".

Cancella gli inserimenti selzionati.

Apre la cella selezionata per effettuarne la modifica Vedete quale cella
e stata selezionata in una riga evidenziata facendo riferimento al
simbolo della lente di ingrandimento nella riga titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.

Apre la finestra Impostazioni per |'inserimento selezionato.

Elimina tutte le impostazioni di filtro

Attiva la guida online

Cartella per file guida per la guida runtime del progetto Questi file vengono salvati in formato *.chm.
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Manager di progetto
Zenon

MENU CONTESTUALE

Inserisci file Apre il Manager file che serve alla selezione di un file.

Nuova cartella Aggiunge una nuova sottocartella.

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in
proprio.

Cancella cartelle Cancella la cartella selezionata, che e stata creata in proprio, dopo la

richiesta di conferma.

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 77) predefiniti.

Guida Attiva la guida online

Guida Barra simboli e menu contestuale

EEREP aaX S sv|dO
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MENU CONTESTUALE GUIDA

Punto di menu

Inserisci file

Modifica file esterni

Modifica file esterni con
Copiare

Incolla

Elimina

Modifica celle
selezionate

Sostituisci testo nella
colonna selezionata...

Proprieta
Elimina tutti i filtri

Guida

9.3.3 Multimedia

Azione

Apre il Manager file che serve alla selezione di un file.

Apre il sistema operativo come programma definito di default per la
modifica del file selezionato.

Apre una lista di programma adatti alla modifica del file selezionato

Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento & gia esistente
con lo stesso nome, il contenuto viene aggiunto come "copia di".

Cancella gli inserimenti selzionati.

Apre la cella selezionata per effettuarne la modifica Vedete quale cella
e stata selezionata in una riga evidenziata facendo riferimento al
simbolo della lente di ingrandimento nella riga titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.

Apre la finestra Impostazioni per |'inserimento selezionato.

Elimina tutte le impostazioni di filtro

Attiva la guida online

File audio e video possono essere integrati nei seguenti formati:

>  *avi

» *.mp3
» *.mpeg
» *.wav

Tenete presente il fatto che, per eseguire questi file sul computer runtime, devono essere disponibili i

corrispondenti Codecs.
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Manager di progetto
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MENU CONTESTUALE

Inserisci file Apre il Manager file che serve alla selezione di un file.

Nuova cartella Aggiunge una nuova sottocartella.

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in
proprio.

Cancella cartelle Cancella la cartella selezionata, che € stata creata in proprio, dopo la

richiesta di conferma.

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 77) predefiniti.

Guida Attiva la guida online

Multimedia Barra simboli e menu contestuale

|E|%%IE’|E§BXIEI=’°~TI§@
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MENU CONTESTUALE MULTIMEDIA

Punto di menu

Inserisci file

Modifica file esterni

Modifica file esterni con
Copiare

Incolla

Elimina

Modifica celle
selezionate

Sostituisci testo nella
colonna selezionata...

Proprieta
Elimina tutti i filtri

Guida

9.3.4 Testi e formati

Testi e formati sono:

Azione

Apre il Manager file che serve alla selezione di un file.

Apre il sistema operativo come programma definito di default per la
modifica del file selezionato.

Apre una lista di programma adatti alla modifica del file selezionato

Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento é gia esistente
con lo stesso nome, il contenuto viene aggiunto come "copia di".

Cancella gli inserimenti selzionati.

Apre la cella selezionata per effettuarne la modifica Vedete quale cella
e stata selezionata in una riga evidenziata facendo riferimento al
simbolo della lente di ingrandimento nella riga titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.

Apre la finestra Impostazioni per |'inserimento selezionato.

Elimina tutte le impostazioni di filtro

Attiva la guida online

» File di testo per la visualizzazione nel progetto

Fine file: . txt

» File di formattazione per la formattazione di stampe

Fine file: . £rm

» File HTML per la visualizzazione in immagini HTML

Fine file: .htm oppure .html
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MENU CONTESTUALE

Inserisci file Apre il Manager file che serve alla selezione di un file.

Nuova cartella Aggiunge una nuova sottocartella.

Rinomina cartella Consente di rinominare delle sottocartelle che sono state create in
proprio.

Cancella cartelle Cancella la cartella selezionata, che € stata creata in proprio, dopo la

richiesta di conferma.

Profilo editor Apre la lista a cascata con i Profili editor (auf Seite 77) predefiniti.

Guida Attiva la guida online

Testi e formati Barra simboli e Menu contestuale

SRR RBRX SlLsF@
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MENU CONTESTUALE TESTI E FORMATI

Punto di menu

Inserisci file

Modifica file esterni

Modifica file esterni con

Copiare

Incolla

Elimina

Modifica celle
selezionate

Sostituisci testo nella
colonna selezionata...

Proprieta
Elimina tutti i filtri

Guida

935 Driver

Azione

Apre il Manager file che serve alla selezione di un file.

Apre il sistema operativo come programma definito di default per la
modifica del file selezionato.

Apre il file selezionato nell’editor standard del formato file, oppure
offre una selezone di editor adatti.

Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento & gia esistente
con lo stesso nome, il contenuto viene aggiunto come "copia di".

Cancella gli inserimenti selzionati.

Apre la cella selezionata per effettuarne la modifica Vedete quale cella
e stata selezionata in una riga evidenziata facendo riferimento al
simbolo della lente di ingrandimento nella riga titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.

Apre la finestra Impostazioni per |'inserimento selezionato.

Elimina tutte le impostazioni di filtro

Attiva la guida online

| file driver possono essere integrati nei seguenti formati:

> *.cfg
> *liso
»  Fitcp
» *bur
» *fms
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» *.bec

» *.ovd
» *.nmp
>  *ini
» *hill
> *lst
» *.dde
» *lon
» *.opc
» *.ecs

Normalmente, qui ci si puo risparmiare |'inserimento. | file vengono automaticamente generati al
momento della installazione del driver e salvati in questa sede.

MENU CONTESTUALE

Punto di menu

Inserisci file
Nuova cartella

Rinomina cartella

Cancella cartelle

Profilo editor

Guida

Azione

Apre il Manager file che serve alla selezione di un file.
Aggiunge una nuova sottocartella.

Consente di rinominare delle sottocartelle che sono state create in
proprio.

Cancella la cartella selezionata, che ¢ stata creata in proprio, dopo la
richiesta di conferma.

Apre la lista a cascata con i Profili editor (auf Seite 77) predefiniti.

Attiva la guida online

Driver Barra simboli e menu contestuale
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MENU CONTESTUALE DRIVER

Punto di menu

Inserisci file

Modifica file esterni

Modifica file esterni con

Copiare

Incolla

Elimina

Modifica celle
selezionate

Sostituisci testo nella
colonna selezionata...

Proprieta

Elimina tutti i filtri

Guida

Azione

Apre il Manager file che serve alla selezione di un file.

Apre il sistema operativo come programma definito di default per la
modifica del file selezionato.

Apre una lista di programma adatti alla modifica del file selezionato

Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento & gia esistente
con lo stesso nome, il contenuto viene aggiunto come "copia di".

Cancella gli inserimenti selzionati.

Apre la cella selezionata per effettuarne la modifica Vedete quale cella
e stata selezionata in una riga evidenziata facendo riferimento al
simbolo della lente di ingrandimento nella riga titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.

Apre la finestra Impostazioni per |'inserimento selezionato.

Elimina tutte le impostazioni di filtro

Attiva la guida online
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9.3.6 Report Viewer

I modelli di report sono dei file in formato RDL 2.0, che possono essere aperti, visualizzati e modificati in zenon

Report Viewer.

MENU CONTESTUALE

Punto di menu

Inserisci file

Nuova cartella

Rinomina cartella

Cancella cartelle

Profilo editor

Guida

Azione

Apre il Manager file che serve alla selezione di un Report File di

definizione.
Aggiunge una nuova sottocartella.

Consente di rinominare delle sottocartelle che sono state create in
proprio.

Cancella la cartella selezionata, che € stata creata in proprio, dopo la
richiesta di conferma.

Apre la lista a cascata con i Profili editor (auf Seite 77) predefiniti.

Attiva la guida online

Indicazione: disponibile solamente se si possiede una licenza per il Generatore di rapporti e il Report

Viewer.

Report Viewer; barra dei simboli e menu contestuale

FTEY By X | &S
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MENU CONTESTUALE; MODELLI REPORT

Punto di menu

Report; Nuovo file di definizione

Report; apri file di definizione

Torna all'elemento originario

Copiare

Incolla

Elimina

Importa file di definizione Report
esistente

Elimina tutti i filtri

Modifica celle selezionate

Sostituisci testo nella colonna
selezionata...

Proprieta
Guida
9.3.7  Altri

Cartella per salvare qualsiasi tipo di file.

Azione

Crea un nuovo file RDL sulla base di default. rdl.

Apre il software connesso ai file RFL al fine di modificare un
file di definizione esistente.

Di default, zenon cerca anzitutto il MS Report Builder, poiil
MS Report Designer.

Nell’'ambito degli elementi collegati, ritorna a quello partendo
dal quale si era passati al modello report.

Questo comando & presente nel menu contestuale solamente
se ci sono degli elementi collegati.

Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento é gia
esistente con lo stesso nome, il contenuto viene aggiunto
come "copia di".

Cancella gli inserimenti selzionati.

Apre il dialogo che serve ad importare un file di definizione
Report gia esistente. Questi file devono essere del tipo RDL
2.0.

Elimina tutte le impostazioni di filtro

Apre la cella selezionata per effettuarne la modifica Vedete
guale cella é stata selezionata in una riga evidenziata facendo
riferimento al simbolo della lente di ingrandimento nella riga
titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.

Apre la finestra Impostazioni per |'inserimento selezionato.

Attiva la guida online
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MENU CONTESTUALE

Manager di progetto

Zzenon

Inserisci file

Apre il Manager file che serve alla selezione di un file.

Nuova cartella

Aggiunge una nuova sottocartella.

Rinomina cartella

Consente di rinominare delle sottocartelle che sono state create in
proprio.

Cancella cartelle

Cancella la cartella selezionata, che e stata creata in proprio, dopo la
richiesta di conferma.

Profilo editor

Apre la lista a cascata con i Profili editor (auf Seite 77) predefiniti.

Guida

Attiva la guida online
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Barra simboli Altro e menu contestuale

MENU CONTESTUALE ALTRO

Punto di menu

Inserisci file

Modifica file esterni

Modifica file esterni con
Copiare

Inserisci

Elimina

Modifica celle
selezionate

Sostituisci testo nella
colonna selezionata...

Proprieta
Elimina tutti i filtri

Guida

9.4

Azione

Apre il Manager file che serve alla selezione di un file.

Apre il sistema operativo come programma definito di default per la
modifica del file selezionato.

Apre una lista di programma adatti alla modifica del file selezionato

Copia gli inserimenti selezionati negli appunti

Aggiunge il contenuto degli appunti. Se un inserimento e gia esistente
con lo stesso nome, il contenuto viene aggiunto come "copia di".

Cancella gli inserimenti selzionati.

Apre la cella selezionata per effettuarne la modifica Vedete quale cella
e stata selezionata in una riga evidenziata facendo riferimento al
simbolo della lente di ingrandimento nella riga titolo.

Apre il dialogo che serve alla ricerca e alla sostituzione di testi.

Apre la finestra Impostazioni per |'inserimento selezionato.

Elimina tutte le impostazioni di filtro

Attiva la guida online

Libreria simboli globale

zenon fornisce tramite la Libreria simboli globale delle grafiche proprie, predefinite. Mentre i

simboli nella cartella 1mmagini sono a disposizione solamente per I'immagine attuale, quelli della

libreria simboli globale possono essere utilizzatiin ogni progetto.

Possono essere anche impostati dei simboli proprio, o riassunti o collegati. | dettagli relativi li potete

trovare nel capitolo Immagini / Simboli
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L'Editor salva lo stato della cartella simboli (aperta o chiusa), anche quando si lascia la biblioteca dei
simboli o si chiude I'Editor.

9.5 Dialoghi di selezione

In zenon ci sono a disposizione dialoghi appositi e liste fitrate per la selezione di determinati elementi.
Essi sono gli stessi in tutto il sistema e tengono presenti i progetti attuali e i loro sottoprogetti. Sono a
disposizione per:

» Utente

» Immagini

» File

» Tipididato
» Funzioni

» Modelli

» Driver

» Variabili

Potete leggere le informazioni dettagliate concernenti le visualizzazioni nel capitolo Visualizzazione
dettagli del Manager di progetto (auf Seite 89); trovate delle informazioni concernenti il filtraggio nel
sottocapitolo Filtra inserimenti lista (auf Seite 97).

Trovate delle informazioni dettagliate concernenti i dialoghi di selezione per funzioni e variabili, nonché
la sostituzione di funzioni e variabili gia selezionate nei sottocapitoli:

» Funzioni (auf Seite 123)

» Variabili (auf Seite 124)
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9.5.1  Funzioni Dialogo di selezione

Al fine di selezionare delle funzioni, viene aperto un dialogo filtrato:

-

% Scelta funzioni &=
=l Workspace C:\Users\Publ S |
EXCHANGE
&l IPA Imp....| Nome # | Tipo Parametri
ﬂ pic E E E
picALARM Cambic immagine | ALARM - [*][*]-[T,Rel:1d,0h,0m,0s]
picEVENTS Cambic immagine | EVENTS - [*][*]-[T,Rel:1d,0h,0m,0s]
picMENU Cambic immagine | MENU
picMENU_DETAIL Cambic immagine | MEMU_DETAIL
picSTART Cambic immagine | START
picSYSTEML Cambic immagine | SYSTEM_1
picSYSTEM2 Cambic immagine | SYSTEM_2
picSYSTEM3 Cambic immagine | SYSTEM_3
picTREND Cambic immagine | TREND - WIZARD TREND[HD]
'l [l v || 77 Totali / 9 Filtrati / 0 Selezionati
oc | [ e | [ cuee
Elemento Descrizione

Struttura ad albero del | Definizione del progetto dal quale deve essere selezionata la funzione.
progetto

Finestra di selezione Selezione della funzione.
Nessuna selezione A seconda delle’elemento:
» il dialogo viene chiuso;

» le funzioni gia collegate vengono cancellate.

Un consiglio: la grandezza di questo dialogo & modificabile. La grandezza e la posizione del dialogo
viene salvata.

MODIFICA FUNZIONI COLLEGATE

1. manualmente

e aprite le funzioni nella Visualizzazione dettagli (auf Seite 87) del manager di
porgetto.
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e trascinate la funzione desiderata sull’elemento tenendo il tasto sinistro del mouse
premuto

e La funzione esistente viene sostituita dalla nuova.

2. automaticamente

e selezionate nel menu contestuale dell’elemento Sostituisci collegameneti. Dettagli
concernenti la procedura da adottare, li trovate nel capitolo Sostituzione di variabili e
funzioni negli elementi dinamici.

9.5.2 Dialogo selezione variabili
Al fine di selezionare delle variabili, viene aperto un dialogo filtrato:

Un consiglio: la grandezza di questo dialogo & modificabile. La grandezza e la posizione del dialogo
viene salvata.

Le variabili possono anche essere utilizzate contemporaneamente per diversi progetti.
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COLLEGAMENTO DI UNA VARIABILE

Gli elementi che possono essere collegati solamente con una singola variabile, aprono il seguente

dialogo:

[®setavorioss &=

Manager di progetto

= ﬂ Workspace C:\Users'\Publ
EXCHANGE
ol IPA

;

9|Bn|s

Nome n||dmmm

Unitd  Indirzzo di ret...

Bloceo dati

mp...

Testo fitro B Tesofitro

Test z Testo fitro z Testo fil

<

Free disk space - Export [...
Free memory [%]
Free memory [KB]
int
Metwork timeout [Millise...
Number of alarms
Mumber of connected cli...
s7
Standalone/Server/Stand...
Tankl_max
Tanlkd_min
Tank2_max
Tank2_min
Tank3_max
Tank3_min
Tankd_max
Tankd_min
'WIZ_LOWER_LIMIT
WIZ_MODE
WIZ_STEPS
WIZ_UPPER_LIMIT
WIZ_VAR_10
WIZ_VAR_11
WIZ_VAR_ 12

m

KB

KB

ms

oo o o0 o000 oo o000 ooooo0ooSooo

)
49 Totali / 34 Filtrati / 1 Selezionati | 1 Tags utilizzate / Tags illimitate |

oo o o0 o000 oo o0oooooooooooo

m

- wone o 00000 000000 o0 o oo

[ o

Zzenon
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Elemento Descrizione

Struttura ad albero del | Definizione del progetto dal quale deve essere selezionata la variabile.
progetto

Finestra di selezione Selezione della variabile che deve essere collegata. Il collegamento puo essere
realizzato in due modi:

» cliccando due volte sulla variabile desiderata. In questo caso, il

dialogo viene chiuso automaticamente.

» Con la selezione della variabile desiderata e con la conferma

realizzata cliccando su OK.

Nessuna selezione A seconda dell’elemento:
» il dialogo viene chiuso;

» Le variabili gia collegate vengono disconnesse (per es. variabili charge

collegate nel server archivi).

Indicazione: se |a variabile desiderata non viene visualizzata, cid pud dipendere da diverse cause:

» avete selezionato un filtro e la variabile desiderata non corrisponde a questo filtro: Controllate
se nella riga filtro e inserito un filtro. L’informazione sugli elementi filtrati inserita sotto la

finestra di selezione & un ulteriore aiuto per il controllo dei filtri impostati.

» |l dialogo viene aperto filtrato dall’editor e la variabile non corrisponde a questo filtro.
L"apertura filtrata si verifica se sono ammissibili solo determinati tipi di dato, come, per esempio,
se non possono essere collegate delle variabili string in corrispondenza ad un elemento dinamico

Valore numerico.

» Avete selezionato il progetto sbagliato nella struttura ad albero.

& Attenzione

Generalmente il dialogo permette la selezione di piti variabili facendo uso delle
combinazoni di tasti comuni di Windows, ma in questo stadio si puo collegare solamente
una variabile. Nel caso di una selezione multipla, solo la prima variabile selezionata

viene attribuita all’elemento.
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Manager di progetto ﬂ

Zzenon

COLLEGAMENTO DI PIU VARIABILI.

Gli elementi che possono essere collegati con pil variabili, aprono il seguente dialogo:

® Scelta variabili (Filtro: variabili Integer) =]
= ﬂ Workspace C:\Users\Publ | § 'd
EXCHANGE AL LI
ﬂ IPA Imp...| Nome / # | |dertificazione Unitd  Indirzzo di ret... Blocco dati Offset |+
Alarms acknowledged 0 0 0
Alarms not acknowledged 0 0 ]
bool 0 0 0||=
Current authorization lev... 0 0 0
Current authorization lev... 0 0 0
Current authorization lev... 0 0 0
Current authorization lev... 0 0 0
Free disk space - Databas... % 0 0 0
Free disk space - Databas... KB 0 0 0
Free disk space - Export [... % 0 0 0
Free disk space - Export [... KB 0 0 0
Free memory [%] % 1] 0 0
Free memory [KE] KB 0 0 1]
Metwork timeout [Millize... ms 1] 0 0|
P F— m ) ) B
« ] v | 49 Totali / 25 Filtrati / 1 Selezionati | 1 Tags utilizzate / Tags illimitate
MNome Identificazione Indirizzo Progetio
Alarms acknowledged Dw (0) 0080.00 EXCHANGE
Alarms not acknowledged DW (0) 0054.00 EXCHANGE
Mgug | | Bmina | [lessuns selesong ok | [ amde | [ ouds
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Elemento Descrizione

Struttura ad albero del | Definizione del progetto dal quale deve essere selezionata la variabile.
progetto

Finestra di selezione Selezione variabili in base a:

» cliccando due volte, la variabile selezionata viene aggiunta alla lista

variabili.

» Con Drag&Drop, la variabile selezionata pu0 essere trascinata nella

lista variabili.

» Selezionare le variabili desiderate. Con I"aiuto del tasto Ctrl1-
oppure di quello shift e possibile selezionare allo stesso tempo piu
variabili. Cliccando su aggiungi,le variabili selezionate vengono

riprese nella lista variabili.

Lista variabili Ordina tutte le variabili selezionate in una lista.

Aggiungi Aggiunge la variabile attualmente selezionata nella finestra di selezione alla
lista variabili.

Rimuovi Rimuove la variabile selezionata nella lista variabili dalla lista.

Nessuna selezione A seconda dell’elemento:

» il dialogo viene chiuso;

» determinati collegamenti, come variabili charge nell archiviazione,

possono essere sciolte.

Indicazione: se |a variabile desiderata non viene visualizzata, cid pud dipendere da diverse cause:

» avete selezionato un filtro e la variabile desiderata non corrisponde a questo filtro: Controllate
se nella riga filtro € inserito un filtro. L’informazione sugli elementi filtrati inserita sotto la

finestra di selezione & un ulteriore aiuto per il controllo dei filtri impostati.

» |l dialogo viene aperto filtrato dall’editor e la variabile non corrisponde a questo filtro.
L"apertura filtrata si verifica se sono ammissibili solo determinati tipi di dato, come, per esempio,
se non possono essere collegate delle variabili string in corrispondenza ad un elemento dinamico

Valore numerico.

» Avete selezionato il progetto sbagliato nella struttura ad albero.
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MODIFICA VARIABILE COLLEGATA

Selezionate nel menu contestuale dell’elemento Sostituisci collegameneti. Dettagli concernentila
procedura da adottare, li trovate nel capitolo Sostituzione di variabili e funzioni negli elementi dinamici.

9.5.3 Modelli

Nel dialogo di selezione Modelli si pud procedere alla selezione di modelli per I'esecuzione di funzioni;
essi provengono da:

» progetto attuale
» sotto-progetti

» tuttii progetti del workspace con |'opzione Mantieni progetto in memoria attiva

¥ Selezione modelli @

- oy Workspace: 700(14) [y | =0 o | 2
oy GLOBALFROJE...
dE TEST700 Imp... Visualiz... | Mome Colore di sfondo Modello a forma libera | Sinistra [Pixel]

i, PRO_E i i i N i T
MO [0 | ALARMSTATUSLINE | [l #FFO000
g [‘g;%s’?%w o MAIN_WIZARD [ #D3D3D3
& FROT MENU_WIZARD I #0000FF
O R_Frame [] #FFFFFF

&
g
oRO0

FRO3
MESSAGEY
SAP

RV

RGM
MULTI_040411
REFORT
TEMPLATES
o D_700

B i o i G B B B

] 1 ¢
< 1 v | 4 Totali / 4 Filtrati / 0 Selezionati

Monitar

[ serolla sul monitor Monitore manca v] [ oK ] [ Annulla ] [ Guida
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Parametri

Finestra Albero di progetto

Finestra Modelli

Proporre questo dialogo nel
runtime

Nessuna selezione

Scrolla sul monitor

Monitor

OK
Annulla

Guida

9.5.4 File

Descrizione

Mostra tutti i progetti del workspace Si puo procedere
alla scelta di modelli selezionandoli tra quelli del progetto
attuale, o fra quelli di tutti i progetti in cui l'opzione
Mantieni progetto in memoria sia attiva

Selezione dei modelli.

Se selezionate diversi modelli, il sistema usa il primo
modello scelto per |'esecuzione della funzione.

Apre durante il Runtime questo dialogo di selezione
modelli nel corso dell’esecuzione della funzione.

Non ha nessuna funzione per questa selezione di modelli.

attiwvo: Durante il Runtime appaiono delle barre di
scorrimento che Vi permettono di effettuare lo scroll.

Questa opzione & a disposizione solamente nei Sistemi
multi-monitor.

Selezione del monitor fra quelli della lista a cascata

Essa contiene:

) monitor attuale

> tutti i monitor virtuali definiti nella gestione monitor

opzionale: tutti i monitor

Questa opzione & a disposizione solamente nei Sistemi
multi-monitor.

Riprende le impostazioni e chiude il dialogo.
Annulla tutte le modifiche e chiude il dialogo.

Attiva la guida online

Nel dialogo di selezione file possono essere selezionati in una visualizzazione filtrata i file del progetto

attuale o di progetti subordinati:
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> Per selezionare un file di un progetto, lo si deve trovare nel nodo File/Grafiche (auf Seite 106) che si trova nel

manager di progetto.

>  Per selezionare un file direttamente da una qualsiasi cartella del computer, si deve attivare la proprieta Selezione

file diretta.

9.5.5 Immagini

Nel dialogo di selezione "Immagini" si puo procedere alla selezione di immagini per |’esecuzione di

funzioni; tali immagini provengono da:

» progetto attuale

» sotto-progetti

» tuttii progetti del workspace con |I'opzione Mantieni progetto in memoria attiva

¥ Selezione Immagine

i

= IﬂE Workspace: 7007(14)

oy TEST700
i, PRO_E

i, MESSAGE
oy IPRO_NETWO...
o PRO1

B
-
e}
=]
(=]

FRO3
MESSAGEY
SAP

RV

RGM
MULTI_040411
REFORT
TEMPLATES
o D_700

B i o i G B B B

4 | i

Proponi dialogo a Runtime

oy GLOBALPROJE...

MULTIMONIT .

=

)

i

|

L=
-

Etat | Nom

TREND
MENU
START
ALARM
EVENTS
AML Filter
CEL filter

al

7 Totali /7 Filtrati / 1 Selezionati

\essuna selezione| [ Scrolla sul monitor

Type de synoptique Gabarit Amiére-plan (couleur)
r W r r
Trend esteso MAIN_WIZARD [] 2030303
Standard MENU_WIZARD Il #0000FF
Standard MAIN_WIZARD [1#D30303
Lista informazioni d'allarm... | MAIN_WIZARD [] 2030303
Lista eventi cronologica (C...  MAIN_WIZARD []#D303D3
Filtro lista informazione all... | MAIN_WIZARD [] 2030303
Filtro CEL MAIN_WIZARD [1#D30303
1 +
Monitar
Monitore manca v] [ OK. ] [ Annulla ] [ Guida
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Parametri Descrizione

Finestra Albero di progetto Mostra tutti i progetti del workspace Si pud procedere
alla scelta di immagini selezionandole tra quelle del
progetto attuale, o fra quelle di tutti i progetti in cui
'opzione Mantieni progetto in memoria sia attiva

Finestra Immagini Scelta dell'immagine

Se selezionate diverse immagini, il sistema usa la prima
immagine scelta per I'esecuzione della funzione.

Proporre questo dialogo nel Apre durante il Runtime questo dialogo di selezione

runtime immagini nel corso dell’esecuzione della funzione.

Nessuna selezione Non ha nessuna funzione per questa selezione
d’immagine.

Scrolla sul monitor attiwvo: Durante il Runtime appaiono delle barre di

scorrimento che Vi permettono di effettuare lo scroll.

Questa opzione & a disposizione solamente nei Sistemi
multi-monitor.

Monitor Selezione del monitor fra quelli della lista a cascata
Essa contiene:
) monitor attuale
> tutti i monitor virtuali definiti nella gestione monitor

> opzionale: tutti i monitor

Questa opzione & a disposizione solamente nei Sistemi
multi-monitor.

Questa opzione & a disposizione solamente nei Sistemi
multi-monitor.

OK Riprende le impostazioni e chiude il dialogo.
Annulla Annulla tutte le modifiche e chiude il dialogo.
Guida Attiva la guida online
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9.5.6  Immagini filtro

Se si passa ad un’immagine con filtro per altre immagini (filtro AML, filtro CEL), si apre un dialogo che

serve a quanto segue:

» immagine che apre

» Immagine da attualizzare

SELEZIONE IMMAGINE IMMAGINE CHE APRE

¥ Selezione Immagine

i

= IﬂE Workspace: 700(14)

MULTIMONIT.

& MRCN W g
Etat | Nom

TREND
MENU
START
ALARM
EVENTS
AML Filter
CEL filter

Type de synoptique

Trend esteso
Standard
Standard

Lista informazicni d'allarm...

Lista eventi cronologica (C...

Filtro lista informazione all...

Filtro CEL

<

I

7 Totali /7 Filtrati / 0 Selezionati

essuna selezione|

# | Gabarit Amiére-plan (couleur)
W r r
MAIN_WIZARD [1#D30303
MEMU_WIZARD Il #0000FF
MAIN_WIZARD [1#D30303
MAIN_WIZARD [1#D30303
MAIN_WIZARD [1#D30303
MAIN_WIZARD [1#D30303
MAIN_WIZARD [1#D30303

2
OK ] [ Annulla ] [ Guida
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Manager di progetto

Zzenon

Mostra il progetto attuale.

Finestra Albero di progetto

Si possono selezionare delle immagini fra quelle

contenute in questo progetto.

Finestra Immagini

Selezione dell'immagine.

Se selezionate pil immagini, il cambio portera

all'immagine scelta per prima.

Nessuna selezione

Non ha nessuna funzione per questa selezione

d’'immagine.
OK Riprende le impostazioni e chiude il dialogo.
Annulla Annulla tutte le modifiche e chiude il dialogo.
Guida Attiva la guida online

SELEZIONE IMMAGINE IMMAGINE DA ATTUALIZZARE

#' Selezione Immagine

- oy Workspace: 700(14) [+ | By o | #
] MULTIMONIT . = =
Etat | Mom # | Type de synoptique " Gabarit Amiére-plan (couleur)
. Testo fitro r Testo fitro W Testo fitro | Testofito W
TREND Trend esteso MAIN_WIZARD [1#D30303
MENU Standard MENU_WIZARD Il #0000FF
START Standard MAIN_WIZARD [1#D30303
ALARM Lista informazioni d'allarm... = MAIN_WIZARD [] 2030303
EVENTS Lista eventi c gica (C... MAIN WIZARD []#D303D3
AML Filter Filtro lista informazione all... = MAIN_WIZARD [] 2030303
CEL filter Filtro CEL MAIN_WIZARD [1#D30303
< I | 3
< 1 | v |7 Totali /7 Filtrati / 1 Selezionati
Mome Tipo di immagine
MEMNU Standard
START Standard
EVENTS Lista eventi cronologica (C...
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Manager di progetto
Zenon

Finestra Albero di Mostra il progetto attuale.

progetto
Si possono selezionare delle immagini fra quelle contenute in questo
progetto.

Finestra Immagini Selezione delle immagini.

E' possibile una selezione multipla. Potete aggiungere altre immagini
cliccando due volte o facendo uso del pulsante Aggiungi.

Finestra Selezione Ordina tutte le immagini selezionate.

Aggiungi Aggiunge gli elementi selezionati alla finestra di selezione.
Rimuovi Cancella gli elementi selezionati dalla finestra di selezione.
Nessuna selezione Rimuove tutte le immagini attualmente collegate.

OK Riprende le impostazioni e chiude il dialogo.

Annulla Annulla tutte le modifiche e chiude il dialogo.

Guida Attiva la guida online
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9.5.7 utente

Manager di progetto

Selezione di utenti del progetto attivo, di tutti i sottoprogetti e del progetto globale.

-
al} Selezione utente M
E"* Workspace: 70014)  |ltente ... | Autorizzazione utente Mome P Livell di aL jone | Gruppi ul
GLOBALPROJE...
£ MESSAGE Test.. ¥ Testo fitro r Testo fitro T [Testof... 7 Testo fitro r Test
< I 3
] ] |+ |0 Totali /0 Filtrati / 0 Selezionati

Lista Workspace

Visualizzazione e selezione dei progetti i cui utenti possono essere
selezionati.

Zzenon

Lista Utenti

Visualizzazione degli utenti del progetto selezionato. Si puo filtrare
questa lista.

Nessuna selezione

Un utente gia selezionato viene deselezionato.

OK Riprende e accetta le modifiche e chiude il dialogo.
Annulla Rifiuta le modifiche e chiude il dialogo.
Guida Apre la guida online

9.5.8 Driver

Nel dialogo di selezione driver possono essere selezionati in una visualizzazione filtrata i driver del

progetto attuale o di progetti subordinati.
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9.5.9 Tipididato

Nel dialogo di selezione tipi di dato possono essere selezionati in una visualizzazione filtrata i tipi di dato
del progetto attuale o di progetti subordinati.

10. Finestra principale

Nella finestra principale vengono visualizzati e modificati documenti come immagini, report e cosi via.
La finistra principale € I'unica finestra che non puo essere nascosta.

APRIRE PARALLELAMENTE PIU DOCUMENTI.

Potete visualizzare nella finestra principale piu immagini nello stesso tempo. Potete attivare questa
funzione tramite: Opzioni > Finestra principale con schede . Le immagini sono raggiungibili mediante tab che
si trovano sul bordo superiore della finestra principale e possono essere ordinate nel punto di menu

Finestra.

Per chiudere delle immagini aperte, usate la combinazione ditasti cCtrl + F4, il menu contestuale
oppure il comando Chiudi > Finestra.

MENU CONTESTUALE DOCUMENTI

Cliccando con il tasto destro del mouse sul tab di un documento si apre un menu contestuale:

Parametri Descrizione

Salva Salva il documento.

Chiudi Chiude questo documento.
Chiudi tutti gli altri. Chiude tutti gli altri documenti.

POSIZIONA ELEMENTI NELL'IMMAGINE

Attivate gli elementi con un clic sul simbolo nella Barra dei simboli Elementi (auf Seite 41) e trascinateli
con il mouse nella finestra principale.

Per muovere |'elemento, avete le seguenti possibilita:
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» Muovere velocemente: cliccare sull’elemento e posizionarlo con il mouse.

» Posizionare esattamente: cliccare sull’elemento e posizionarlo con i tasti di direzione (con le

frecce).

» Gira: girare I'elemento a piacere tenendolo per I’angolo in alto a sinistra.

11. Finestra di Proprieta

Nella finestra delle proprieta vengono visualizzati i parametri e le proprieta degli oggetti che sono stati
selezionati nella sezione lista del manager di progetto, oppure degli elementi che sono stati selezionati
nell'immagine. Nella finestra delle proprieta, inserite i valori e i parameteri per oggetti e elemento
selezionati oppure modificateli.

Quelle concernenti il modo di visualizzazione, I'ordinamento ed i favoriti, vengono salvati per il nuovo
avvio dell'editor. Modificando delle proprieta di elementi nella finestra delle proprieta, viene
selezionata automaticamente |'ultima proprieta modificata nel momento in cui si seleziona un nuovo
elemento.

SELEZIONE MULTIPLA

Se selezionate parallelamente pil oggetti (selezione multipla), tutte le proprieta che sono differenti
negli elementi selezionati, vengono rappresentate nella finestra delle proprieta in color arancione,
oppure evidenziate in colore rosso. Le proprieta dell’'ultimo elemento selezionato vengono visualizzate:
Nella visuale Visuale raggruppata (auf Seite 141) e in Tutte le proprieta (auf Seite 143) si pud
trasmettere la proprieta desiderata a tutti gli oggetti selezionati pigiando il testo Invio. (Cio non &
possibile nella Opzione dialogo (auf Seite 142).)

# Esempio

Sono selezionati diversi oggetti caratterizzati da differenti colori di riempimento.
L’ultimo elemento selezionato é caratterizzato dal colore di riempimento verde. La
proprieta Colore di sfondo verra visualizzata in verde e il valore #32CD32 é
evidenziato in rosso . Cliccando sul campo di inserimento e pigiando il tasto Invio si

trasmette la proprieta verde a tutti gli elementi selezionati.
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Finestra di Proprieta

Zzenon

IMPIEGO TASTIERA

Si pud navigare nelle proprieta anche con la tastiera:

Tab oppure Su Passa alla proprieta successiva.
Shift+Tab oppure Passa alla proprieta precedente.
Giu

Enter oppure A Apre un nodo.

destra

A sinistra Salta un nodo.

Pos 1 Torna al primo nodo

Fine Torna all’ultimo nodo

BARRA SIMBOLI

Le proprieta di un oggetto vengono visualizzate e modificate nella finestra delle proprieta. Per
organizzare la finestra delle porprieta € a Vostra disposizione una barra di simboli:
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Simbolo

(da sinistra a destra)
Gruppi di

rappresentazione
(auf Seite 141)

(default)

Tutte le
proprieta
Seite 143)

(auf

Vista a dialogo
(auf Seite 142)

Mostra/nascondi i
favoriti (auf Seite 143)

Mostra/nascondi
tutte le
proprieta

Ordinamento
logico

(default)

Ordinamento
crescente e
decrescente

Funzione

Tutte le proprieta dell’oggetto selezionato vengono raggruppate secondo
un criterio logico e i gruppi vengono ordinati o in ordine alfabetico
oppure in modo logico. Attraverso il menu contestuale possono essere
aggiunti o eliminati inserimenti dai Favoriti.

Standard per il manuale: le indicazioni del manuale sulle proprieta
partono sempre dalla visualizzazione a gruppi. | contenuti dei gruppi
corrispondono quellidella Visuale a dialogo.

Tutte le proprieta dell'oggetto selezionato vengono rappresentate in una
lista. Attraverso il menu contestuale possono essere aggiunti o eliminati
inserimenti dai Favoriti.

Tutte le proprieta vengono riassunte in modo logico come nei Gruppi
di rappresentazione eigruppisono ordinati secondo la
frequenza e la priorita del loro uso. In questa visualizzazione non
possono essere definiti dei favoriti.

Mostra o nascondo nelle visuali Gruppi di rappresentazione
oppure Tutte le proprieta il nodo Favoriti.In esso sono raccolte
quelle proprieta che vengono utilizzate piu frequentemente.

Di default vengono proposti dei favoriti.

Aggiungi o cancella dai favoriti degli inserimenti: Cio accade mediante il
menu contestuale 'Aggiungi ai favoriti', 0 mediante Drag&Drop
delle proprieta nella lista dei favoriti.

La successione delle proprieta nei favoriti viene definita dal criterio di
classificazione prescelto (ordine crescente, decrescente, logico).

Nellavisuale di dialogo non possono essere creati dei favoriti.

Mostra o nasconde tutti i nodi nelle visuali Raggruppato e Tutte le
proprieta

Mostra nelle visuali Raggruppatoe Tutte le proprieta le proprieta
ordinate in modo logico secondo la frequenza d’uso invece che in ordine
alfabetico.

Mostra nelle visuali Raggruppatoe Tutte le proprieta le proprieta
ordinate in ordine alfabetico crescente o decrescente.
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Apri/chiudi tutti
i nodi

Mostra guida
delle proprieta
(auf Seite 145)

Rendi disponibili
proprieta

Opzioni per barre
dei simboli

Apre o chiude nelle visuali Raggruppato e Tutte le proprietatuttii
nodi.

Eccezione: il nodo delle proprieta attualmente selezionate rimane
aperto cliccando su Chiudi tutti i nodi.

Mostra la guida integrata che concerne le proprieta (guida delle
proprieta).

Simboli: rende disponibile la Proprieta selezionata.

Cliccando sulla freccia si apre il sotto-menu:
attivo:viene visualizzata la barra dei simboli.

Se non appare la barra dei simboli, la si puo rendere attiva facendo uso
del menu Opzioni -> Barre dei simboli.

11.1 \Visualizzazione a gruppi

laVisualizzazione a gruppi e selezionata di Default. Essa raccoglie in gruppi secondo un
criterio logico delle proprieta che hanno tratti comuni.

Proprietd: Immagine: ALARM - Progetto: EXCHANGE Lo~ X
B2 B(=)= B2 8= @  Immagine: ALARM - Progetto: EXCHANGE
+| Esecuzione: i

= Generale
Colore di sfondo ZEFEFEF
Gruppi d'impianto < nessun gruppo di impianto collegato »

+/| Immagine di sfondo

Layout tastiera automatica -

Modello MAIN_WIZARD 3
MNome ALARM

MNome file 208262 cc-ebfc-4b95-9a3c-balB72c3f1800

Tipo di immagine Lista informazioni d'allarme (AML)
Visibile sotto CE ¥

+/| Stile Finestra

Tutte le proprieta possono essere visualizzate e escluse facendo uso della barra dei simboli.
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¥ Informazioni

Le indicazioni del manuale sulle proprieta partono sempre dalla visualizzazione a

gruppi .. | contenuti dei gruppi corrispondono quelli della Visuale a dialogo.

11.2 Vista a dialogo

LaVisualizzazione dialogo riassume le proprieta in gruppi e le presenta sotto forma di
dialogo.

Proprietd: Immagine: ALARM - Progetto: EXCHANGE

g - x
BEB @ | I gine: ALARM - Prog EXCHANGE
. j Istra Generale
) Dimensione ez ALARM
) Esecuzione: Tipo di immagine: | Lista informazioni d'allarme [AML)
Medello: MAIN_WIZARD -
Colore di sfondo: #EFEFEF [
[¥ Visibile sotto CE B
Mome file: 208262cc-eb8c-4b95-9a3c-ba872c3f18b0
Gruppi d'impiant... < nessun gruppe di impiante collegato = (...
Immagine di sfondo
File grafico: <Nessun file» [
Orientarnento:

NellaVisualizzazione dialogo non possono essere impostati dei favoriti e non possono essere
nascoste delle proprieta.
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11.3 Tutte le proprieta

Tutte le proprieta vengono presentate dal sistema in una lista organizzata in ordine
cronologico.

Proprietd: Immagine: ALARM - Progetto: EXCHANGE Lo~ X
HEE B(=)= B2 8= @  Immagine: ALARM - Progetto: EXCHANGE
Nome ALARM it
Tipo di immagine Lista informazioni d'allarme (AML)
Tutte le proprieta
Alterza [Pixel] 1106
Colore di sfondo #EFEFEF
Dialoge modale -
Dirmensione dal modello v

Funzione partenza
Funzione termine

Gruppi d'impianto

*l| Immagine di sfondo

Larghezza [Pixel]

Layout tastiera automatica
Modello

MNome

MNome file

< MNessuna funzione collegata >

< MNessuna funzione collegata >

< nessun gruppe di impianto collegato =

1600

r
MAIN_WIZARD
ALARM

208262cc-eb8c-4b85-9a3c-badT2c3f18b0

m

Tutte le proprieta possono essere visualizzate e escluse facendo uso della barra dei simboli.

11.4 Favoriti

Le visuali Raggruppato e Tutte le proprieta dispongono di un nodo Favoriti che sitrova
nella parte superiore della finestra. Qui vengono visualizzate quelle porprieta che sono utilizzate piu
frequentemente.

Di default vengono proposti dei favoriti. Per aggiungere dei proprio inserimenti, procedete come segue:

» cliccate con il tasto destro del mouse sulla proprieta desiderata;
» selezionate nel menu contestuale <Aggiungi proprieta >ai Favoriti

» Lasuccessione delle proprieta nei favoriti viene definita dal criterio di classificazione (auf Seite

144) prescelto (ordine crescente, decrescente, logico).

Per eliminare degli inserimenti dai favoriti, procedete come segue:

» cliccate con il tasto destro del mouse sulla proprieta desiderata;

» selezionate nel menu contestuale <Elimina proprieta >dai Favoriti
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| favoriti possono essere mostrati o nascosti facendo uso al pulsante corrispondente che si trova nella
barra dei simboli.
Attenzione: Nella Visualedi dialogo non possono essere creati dei favoriti.

Proprietd: Immagine: ALARM - Progetto: EXCHANGE Lo~ X
B2 B(=)= B2 8= @  Immagine: ALARM - Progetto: EXCHANGE

=I| Preferiti

Colore di sfondo #EFEFEF

Funzione partenza < Nessuna funzione collegata »
Funzione termine < Nessuna funzione collegata »
Medello MAIN_WIZARD

MNome ALARM

Tipe di immagine Lista informazioni d'allarme (AML)

+/| Dimensione
+/| Esecuzione:

+/| Generale

+/| Stile Finestra

11.5 Ordina proprieta

Il criterio di classificazione viene definito nella barra simboli usando i pulsanti 'ordina in modo
logico', 'ordina in modo crescente'e€ 'ordina in modo decrescente'. Di default le proprieta sono

visualizzate nella classificazione logica. C'e la possibilita di ordinarle in modo alfabetico.

ORDINAMENTO LOGICO

Le proprieta vengono ordinate in modo logico secondo il loro uso probabile. Cio e possibile pero solo
nella visuale'Raggruppato'e'Tutte le proprieta'.

ORDINA IN SENSO CRESCENTE / DECRESCENTE

Le proprieta vengono ordinate secondo la successione alfabetica crescente o decrescente. Cio &
possibile per la la visuale Raggruppato, Tutte le proprieta e periFavoriti.

CHIUDI E APRINODO

Nelle visualizzazioni Raggruppato e Tutte le proprieta e possibile chiudere tuttiinodie
riaprirli. Il nodo delle proprieta attuali non viene chiuso se viene selezionato Chiudi tutti i
nodi.
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12.Help proprieta

Sotto le proprietd puo essere aperta una finestra contenente la guida in linea per le proprieta.

Guida delle proprieta =]

Benvenuti nella guida concernente le proprieta di zenon.

Questa guida intende mostrarvi delle brevi informazioni relative ad ogni singola
proprieta: a che cosa serve la proprieta in questione, qual’é il suo valore
standard, da quale altre proprieta essa dipende ecc.. Viviene messo a
disposizione anche un link che rimanda alla pagina corrispondente della guida
in linea; inoltre, viene visualizzato il nome della proprieta per VBA/NVSTA.

Per aprire la guida delle proprieta:

» selezionate nella barra simboli delle proprieta il simbolo Mostra giuda delle proprieta (sul

margine destro)

EEEN R N = == e |

» oppure selezionate nel menu opzioni il comando Guida delle proprieta
» oppure cliccate con il tasto destro del mouse su una qualsiasi barra titoli e selezionate poi nel
menu contestuale il comando Guida delle proprieta

Per chiudere la giuda delle proprieta:

» cliccate sulla x che si trova sul bordo destro della barra titoli.

Al contrario di quanto accade nella guida in linea che si apre con il tasto F1, in questa forma di help
viene descritta solamente la proprieta selezionata. Vivengono fornite delle brevi indicazioni
concernenti la proprieta attualmente selezionata e Vi viene fornito un link per la pil esaustiva guida in
linea.
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La guida delle proprieta puo essere, come tutte le altre finestre, posizionata liberamente sullo schermo.

Proprietd: Immagine: combi - Progetto: DOKL Lo X
B2 B[E)= EE ¥= [@ Immagine: combi- Progetto: DOKU
+l| Preferiti o

+/| Dimensione

+/| Esecuzione:

= Generale
Colore di sfendo 2EFEFEF |
Gruppi d'impianto < nessun gruppo di impianto collegato »

T

Immagine di sfondo

Layout tastiera automatica -

Modello MAIN_WIZARD

MNome combi

Mome file 3b#80bl c-4f6f-4aa3-badc-185030b03372

Tipe di immaaine Standard -
Guida delle proprieta Lo X

Interno ID: ID_PICTURE_TITLE

Nome

MNome univoco dellimmagine.
Default: Picture x (x & un numero progressiva).

Ulteriori informazioni nella guida in linea

in VBA (con nome di classe) e nell” esportazione XML (senza nome di classe) come segue: "Title"

Pronto

13. Finestra di emissione

La finestra di emissione mostra le informazioni di stato e le segnalazioni di errore al momento dell’avvio
dell’editor, nonché al momento della compilazione e trasmissione di un progetto. Le informazioni sono
ordinate in diversi tipi:

» Errore

» Avvisi
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» Messaggi

QA @ax|re

sea.cmp ;I
remas . Ccup
scripts.cmp
project.cmp
archiv.cmp
Project.vba
Project.pce
vsta.zip
ZENCONSTR.TXT
project.ini
monitor.mon

project.mdb I1 file non verra sovrascritto!

#%% Sono stati copiati 31 File(s) nella cartella Runtime del progetto 'EXCHANGE'.

-

4| | Ay

Queste informazioni possono essere visualizzate e nascoste a piacere. Le impostazioni che stabiliscono
quali informazioni devono essere visualizzate, sono conservate al momento della chiusura dell’editor e
valgono anche per la visualizzazione delle nuove informazioni. Tuttavia non va perduta nessuna
informazione, visto che le impostazioni hanno effetto solamente sulle modalita di visualizzazione e non
sulla raccolta delle informazioni.

Esempio: Nel caso in cui le segnalazioni sono nascoste, non ne viene visualizzata nessuna finché non ne
viene ripristinata la visualizzazione. A partire da questo momento, tutte le segnalazioni tornano ad
essere visibili. Vengono naturalmente visualizzate anche quelle segnalazioni che sono giunte nel
frattempo.

Le informazioni blu non possono essere nascoste, visto che si tratta di segnalazioni che concernono il
progetto e che debbono rimanere sempre visibili.

BARRA SIMBOLI E MENU CONTESTUALE

4

=

L e

i

X R

FE

Simboli e menu contestuale offrono le stesse opzioni. | simboli significano da sinistra a destra:
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simbolo/Inserimento
menu contestuale

Visualizza
errore

Visualizza
avvisi

Visualizza
segnalazioni

Salva

Copiare

Elimina

Cerca

Guida

= Esempio

Descrizione

Attivo: Errori vengono visualizzatiin color rosso.
Disattivato: Errori vengono nascosti.

Lo stato selezionato pud essere combinato con Avvisi eSegnalazioni e viene
salvato al momento della chiusura dell’editor.

Attivo: Avvisi vengono visualizzati in color arancione.
Disattivato: Avvisi vengono nascosti.

Lo stato selezionato puo essere combinato con Errori eSegnalazioni e viene
salvato al momento della chiusura dell’editor.

Attivo: segnalazioni vengono visualizzatiin color nero.
Disattivato:

Segnalazioni vengono nascoste

Lo stato selezionato puo essere combinato con Errori eAvvisi e viene salvato al
momento della chiusura dell’editor.

Salva l'intero contenuto della finestra di emissione in un file LOG. |l posto in cui
viene salvato il file e il nome dello stesso possono essere scelti liberamente.

Copia i testi evidenziati della finestra di emissione negli appunti.

Cancella il completo contenuto della finestra emissione. Dopo |'esecuzione di
guesta azione non c’e piu la possibilita di recuperare il contenuto cancellato della
finestra di emissione.

Apre il dialogo che serve alla ricerca del testo all’interno della finestra di emissione.

Apre la pagina della guida in linea.

Cancellate il contenuto della finestra di emissione facendo uso del simbolo corrispondente oppure del

menu contestuale e create poi i file runtime. Otterrete nella finestra di emissione le informazioni

corrispondenti. Queste informazioni sono inserite in segnalazioni blu.

1. Cliccate sul simbolo segnalazioni: le segnalazioni standard (testo di color nero) vengono

nascoste.

2. Create ancora una volta i file runtime; le segnalazioni continuano a rimanere invisibili.
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3. Nascondete anche la visualizzazione di Exrrori (rossi) e avvisi (arancioni).
4. Le segnalazioni blu, quelle relative al progetto, continuano ad essere visibili.

5. Create di nuovo file runtime, e riattivate la visualizzazone delle segnalazioni: Tutte le
segnalazioni generate dal momento della cancellazione della finestra di emissione sono di

nuovo visibili.

14. Riga di stato

La barra di stato dell’editor contiene delle informazioni che dipendono dall’oggetto selezionato; queste
informazioni sono su:

Pronta Cursore mouse 47/349 Bargret: Bargeaph Punto di start X/¥: 24/141 Larghezza/altesss 3017461

» disponibilita dell’editor.

» Funzione del simbolo sulla quale si trova il puntatore del mouse.
» Posizione del puntatore del mouse in immagini.

» Tipo e nome dell’elemento attivo in un’immagine.

» Punto di partenza (asse x/y), nonché larghezza e altezza dell’elemento attivo in un’immagine.

Il punto 0/0 dell’asse si trova nell’angolo sinistro in alto.

Nel caso dei report, la barra di stato e senza funzione.
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Chiudi I'Editor
Zenon

15. Chiudi I'Editor

Quando chiudete |'editor, il sistema provvede a controllare (come in caso di chiusura o cambio del posto
di lavoro) tutti i progetti per verificare |'esistenza di modifiche. | progetti i cui file runtime non sono stati
ancora generati, vengono presentati in un dialogo sotto forma di lista; il sistema propone di generarli.

Compilazions file Runtime

Compila file modificati
EDITOR.

l i I [ Mo ] [ Annulla ] [ Guida ]
Si Vengono generati i file runtime di tutti i progetti nella lista. Poi |’editor viene
chiuso.
No | file runtime non vengono generati. L’editor viene chiuso.
Esci | file runtime non vengono generati. L'editor non viene chiuso.
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